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Reference: Locations of Microsoft Office Word 2003 commands in Microsoft Office Word 2007

Tips for using this workbook

1. The order of the worksheets matches the order of the default user interface (Ul). If you prefer,
rearrange the worksheets so that the menus and toolbars that you use most often are on the leftmost
side of the workbook.

2. The names of the worksheet tabs match the menu and toolbar names in Word 2003.

3. To search for a specific command in this workbook, do one of the following:
* In Excel 2003, on the Edit menu, click Find.
* In Excel 2007, on the Home tab, in the Editing group, click Find & Select, and then click Find.

4. To print, do one of the following:
* In Excel 2003, on the File menu, click Print. Under Print what, select an option to print the selection,
the active sheet(s), or the entire workbook.

* In Excel 2007, click the Microsoft Office Button ! a ’
and then click Print. Under Print what, select an option to print the selection, the active sheet(s), or the

entire workbook.

5. A command that is preceded by an asterisk (*) is available only when the language that uses the
command has been enabled for editing text.
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Word: File

Word 2003 Location

Word 2007 Location

New

Open

Close

Save

Save

Save As

Save as Web Page

File Search

Permission (Unrestricted Access)
Permission (Unrestricted Access)
Permission (Unrestricted Access)
Permission (Do Not Distribute)
Permission (Do Not Distribute)
Permission (Do Not Distribute)
Permission (Do Not Reply All)
Permission (Do Not Reply All)
Permission (Do Not Reply All)
Permission (Restrict Permission As)
Permission (Restrict Permission As)
Permission (Restrict Permission As)
Permission

Check Out

Check In

Version History (In My Computer)

Version History (In a Document Library)
Web Page Preview

Page Setup
Page Setup
Print Preview
Print

Print

Send To (Reply with Changes)

Send To (Malil Recipient - for Review)

Send To (Mail Recipient - as Attachment)
Send To (Routing Recipient)

Send To (Exchange Folder)

Send To (Online Meeting Participant)

Send To (Recipient using a Fax Modem

Send To (Recipient using Internet Fax Service)
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Office Button | New

Office Button | Open

Office Button | Close

Quick Access Toolbar | Save

Office Button | Save

Office Button | Save As

In the Save As dialog box, select Web Page in the Save as type list.
Use search in Microsoft Windows to find files

Office Button | Prepare | Restrict Permission | Unrestricted Access
Developer | Protect | Protect Document | Unrestricted Access
Review | Protect | Protect Document | Unrestricted Access

Office Button | Prepare | Restrict Permission | Restricted Access
Developer | Protect | Protect Document | Restricted Access
Review | Protect | Protect Document | Restricted Access

Office Button | Prepare | Restrict Permission

Developer | Protect | Protect Document

Review | Protect | Protect Document

Office Button | Prepare | Restrict Permission | Manage Credentials
Developer | Protect | Protect Document | Manage Credentials
Review | Protect | Protect Document | Manage Credentials

Office Button | Prepare | View Permission

Office Button | Server | Check Out

Office Button | Server | Check In

Removed from product

Office Button | Server | View Version History
Office Button | Word Options | Customize | All Commands | Web Page Preview

Print Preview | Page Setup | Page Setup

Page Layout | Page Setup | Page Setup

Office Button | Print | Print Preview

Office Button | Print

Print Preview | Print | Print

Office Button | Word Options | Customize | All Commands | Reply with
Changes

Office Button | Word Options | Customize | All Commands | Send for Review

Office Button | Send | E-mail
Removed from product

Office Button | Word Options | Customize | All Commands | Send to Exchange
Folder

Removed from product
Removed from product

Office Button | Send | Internet Fax
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Word: File

Word 2003 Location

Word 2007 Location

Send To (Microsoft Office PowerPoint)

Properties

Recently Used Documents
Sign Out

Exit
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Office Button | Word Options | Customize | All Commands | Send to Microsoft
Office PowerPoint

Office Button | Prepare | Properties

Office Button | Most Recently Used Documents
Removed from product

Office Button | Exit
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Word: Edit

Word 2003 Location

Word 2007 Location

Undo

Redo

Cut

Cut

Copy

Copy

Office Clipboard
Office Clipboard
Paste

Paste

Paste

Paste

Paste Special
Paste Special
Paste as Hyperlink
Paste as Hyperlink

Clear (Formats)
Clear (Contents)

Select All
Find
Replace
GoTo

* Reconvert
Links
Object
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Quick Access Toolbar | Undo

Quick Access Toolbar | Redo

Blog Post | Clipboard | Cut

Home | Clipboard | Cut

Blog Post | Clipboard | Copy

Home | Clipboard | Copy

Blog Post | Clipboard | Office Clipboard
Home | Clipboard | Office Clipboard

Blog Post | Clipboard | Paste

Home | Clipboard | Paste

Blog Post | Clipboard | Paste | Paste

Home | Clipboard | Paste | Paste

Home | Clipboard | Paste | Paste Special
Blog Post | Clipboard | Paste | Paste Special
Blog Post | Clipboard | Paste | Paste as Hyperlink
Home | Clipboard | Paste | Paste as Hyperlink

Home | Font | Clear Formatting
Office Button | Word Options | Customize | All Commands | Contents

Home | Editing | Select | Select All

Home | Editing | Find

Home | Editing | Replace

Home | Editing | Find | Go To

Context menus

Office Button | Prepare | Edit Links to Files

Double-click an object to edit it.
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Word: View

Word 2003 Location

Word 2007 Location

Normal

Web Layout
Print Layout
Reading Layout
Outline

Task Pane

Toolbars (Standard)

Toolbars (Formatting)

Toolbars (AutoText)

Toolbars (Control Toolbox)

Toolbars (Database)

Toolbars (Drawing)

Toolbars (E-mail)

Toolbars (Extended Formatting)

Toolbars (Forms)

Toolbars (Frames)

Toolbars (Function Key Display)

* Toolbars (Japanese Greetings)

Toolbars (Mail Merge)

Toolbars (Outlining)
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View | Document Views | Draft

View | Document Views | Web Layout

View | Document Views | Print Layout

View | Document Views | Full Screen Reading
View | Document Views | Outline

Some Dialog Box Launchers display a task pane.

For example, the Dialog Box Launcher in the Styles group of the Home tab
displays the Styles task pane.

Toolbars have been removed from the product.

To find commands on the Standard toolbar, go to the Standard Toolbar
sheet of this workbook.

Toolbars have been removed from the product.
To find commands on the Formatting toolbar, go to the Formatting Toolbar
sheet of this workbook

Toolbars have been removed from the product.
To find commands on the AutoText toolbar, go to the AutoText Toolbar
sheet of this workbook

Toolbars have been removed from the product.

To find commands on the Control Toolbox toolbar, go to the Control Toolbox
Toolbar sheet of this workbook

Toolbars have been removed from the product.

To find commands on the Database toolbar, go to the Database Toolbar
sheet of this workbook.

Toolbars have been removed from the product.
To find commands on the Drawing toolbar, go to the Drawing Toolbar sheet
of this workbook

Toolbars have been removed from the product.
To find commands on the E-mail toolbar, go to the E-mail Toolbar sheet of
this workbook.

Toolbars have been removed from the product.
To find commands on the Extended Formatting toolbar, go to the Extended
Formatting Toolbar sheet of this workbook.

Toolbars have been removed from the product.
To find commands on the Forms toolbar, go to the Forms Toolbar sheet of
this workbook.

Toolbars have been removed from the product.
To find commands on the Frames toolbar, go to the Frames Toolbar sheet
of this workbook.

Toolbars have been removed from the product.
To find commands on the Function Key Display toolbar, go to the Function
Key Display Toolbar sheet of this workbook.

Toolbars have been removed from the product.
To find commands on the Japanese Greetings toolbar, go to the Japanese
Greetings Toolbar sheet of this workbook.

Toolbars have been removed from the product.
To find commands on the Mail Merge toolbar, go to the Mail Merge Toolbar
sheet of this workbook.

Toolbars have been removed from the product.

To find commands on the Outlining toolbar, go to the Outlining Toolbar
sheet of this workbook
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Word: View

Word 2003 Location

Word 2007 Location

Toolbars (Picture)

Toolbars (Reviewing)

Toolbars (Tables and Borders)

Toolbars (Task Pane)

Toolbars (Visual Basic)

Toolbars (Web)

Toolbars (Web Tools)

Toolbars (Word Count)

Toolbars (WordArt)

Toolbars (Customize)
Ruler

Ruler

* Gridlines

* Show Paragraph Marks
Document Map
Thumbnails

Header and Footer
Footnotes

Markup

HTML Source

Full Screen

Zoom
Zoom

Zoom
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Toolbars have been removed from the product.
To find commands on the Picture toolbar, go to the Picture Toolbar sheet of
this workbook

Toolbars have been removed from the product.
To find commands on the Reviewing toolbar, go to the Reviewing Toolbar
sheet of this workbook

Toolbars have been removed from the product.
To find commands on the Tables and Borders toolbar, go to the Tables and
Borders Toolbar sheet of this workbook

Some Dialog Box Launchers display a task pane.
For example, the Dialog Box Launcher in the Styles group of the Home tab
displays the Styles task pane.

Toolbars have been removed from the product.
To find commands on the Visual Basic toolbar, go to the Visual Basic
Toolbar sheet of this workbook

Toolbars have been removed from the product.
To find commands on the Web toolbar, go to the Web Toolbar sheet of this
workbook

Toolbars have been removed from the product.
To find commands on the Web Tools toolbar, go to the Web Tools Toolbar
sheet of this workbook.

Toolbars have been removed from the product.
To find commands on the Word Count toolbar, go to the Word Count
Toolbar sheet of this workbook.

Toolbars have been removed from the product.
To find commands on the WordArt toolbar, go to the WordArt Toolbar sheet
of this workbook

Office Button | Word Options | Customize
Print Preview | Preview | Show Ruler
View | Show/Hide | Ruler

View | Show/Hide | Gridlines

Home | Paragraph | Show/Hide Paragraph Marks
View | Show/Hide | Document Map

View | Show/Hide | Thumbnails

Insert | Header & Footer

References | Footnotes | Show Notes
Review | Tracking | Show Markup
Removed from product

Office Button | Word Options | Customize | All Commands | Full Screen
Reading

Print Preview | Zoom | Zoom
View | Zoom | Zoom

Status Bar | Zoom Slider
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Word: Insert

Word 2003 Location

Word 2007 Location

Break

Page Numbers

Page Numbers

Date and Time

Date and Time

AutoText (AutoText)
AutoText (New)

AutoText (List of AutoText Entries)
Field

Field

Symbol

Comment

Ink Comment

Ink Annotations

* Number

Reference (Footnote)
Reference (Caption)
Reference (Cross-reference)
Reference (Cross-reference)
Reference (Index and Tables)
Reference (Index and Tables)
Reference (Index and Tables)
Reference (Index and Tables)
Web Component

Picture (Clip Art)

Picture (Clip Art)

Picture (From File)

Picture (From File)

Picture (From File)

Picture (From Scanner or Camera)
Picture (Ink Drawing and Writing)

Picture (New Drawing)
Picture (AutoShapes)
Picture (AutoShapes)
Picture (WordArt)

Picture (Organization Chart)
Picture (Chart)

Diagram

Text Box
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Insert | Pages | Page Break

Insert | Header & Footer | Page Number

Header & Footer Tools | Design | Header & Footer | Page Number
Insert | Text | Date & Time

Header & Footer Tools | Design | Insert | Date & Time

Insert | Text | Quick Parts

Office Button | Word Options | Customize | All Commands | Create
Insert | Text | Quick Parts

Insert | Text | Quick Parts | Field

Header & Footer Tools | Design | Insert | Quick Parts | Field
Insert | Symbols | Symbol

Review | Comments | New Comment

Review | Ink | Start Inking

Review | Ink | Start Inking

Insert | Symbols | Number

References | Footnotes | Footnote and Endnote Dialog
References | Captions | Insert Caption

Insert | Links | Cross-reference

References | Captions | Cross-reference

Office Button | Word Options | Customize | All Commands | Index and
References | Table of Contents | Table of Contents

References | Index | Insert Index

References Table of Authorities | Insert Table of Authorities
Office Button | Word Options | Customize | All Commands | Web
Insert | lllustrations | Clip Art

Header & Footer Tools | Design | Insert | Clip Art

Insert | lllustrations | Picture

Header & Footer Tools | Design | Insert | Picture

Chart Tools | Layout | Insert | Picture

Removed from product
Review | Inking | Start Inking

Insert | lllustrations | Shapes | New Drawing Canvas
Insert | lllustrations | Shapes

Drawing Tools | Format | Insert Shapes

Insert | Text | WordArt

Insert | lllustrations | SmartArt

Insert | lllustrations | Chart

Insert | lllustrations | SmartArt

Insert | Text | Text Box | Text Box
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Word: Insert

Word 2003 Location
Text Box

Text Box
File
Object
Bookmark

Hyperlink
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Word 2007 Location

Chart Tools | Layout | Insert | Draw Text Box | Text Box
Text Box Tools | Format | Text | Draw Text Box | Text Box
Insert | Text | Object | Text from File

Insert | Text | Object

Insert | Links | Bookmark

Insert | Links | Hyperlink
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Word: Format
Word 2003 Location Word 2007 Location

Font > Blog Post | Basic Text | Font

Font > Home | Font | Font

Paragraph > Home | Paragraph | Dialog Box Launcher

Paragraph > Page Layout | Paragraph | Paragraph

Bullets and Numbering Office B.utton | Word Options | Customize | All Commands | Bullets and
Numbering

Bullets and Numbering > Home | Paragraph | Bullets

Bullets and Numbering > Home | Paragraph | Numbering
Home | Paragraph | Arrow next to the most recently used command: a

Borders and Shading > border command or Horizontal Line, Draw Table, View Gridlines, or Borders
and Shading

Borders and Shading > Home | Paragraph | Shading

Columns > Page Layout | Page Setup | Columns | More Columns

Tabs > Home | Paragraph | Dialog Box Launcher | Tabs

Drop Cap > Insert | Text | Drop Cap | Drop Cap Options

* Text Direction > Page Layout | Page Setup | Text Direction | Text Direction Options

Change Case > Home | Font | Change Case

* Fit Text > Home | Paragraph | Asian Layout | Fit Text

* Asian Layout > Home | Paragraph | Asian Layout

* Asian Layout (Phonetic Guide) > Home | Paragraph | Asian Layout | Phonetic Guide

* Asian Layout (Enclose Characters) > Home | Font | Enclose Characters

* Asian Layout (Horizontal in Vertical > Home | Paragraph | Asian Layout | Horizontal in Vertical

* Asian Layout (Combine Characters > Home | Paragraph | Asian Layout | Combine Characters

* Asian Layout (Two Lines in One) > Home | Paragraph | Asian Layout | Two lines in One

Background > Page Layout | Page Background | Color

Theme > Page Layout | Themes | Themes

Frames > Office Button | Word Options | Customize | All Commands | Frames

Office Button | Word Options | Customize | All Commands | Table of

Frames (Table of Contents in Frame] > .
Contents in Frame

Frames (New Frames Page) > Office Button | Word Options | Customize | All Commands | New Frames
AutoFormat > Office Button | Word Options | Customize | Al Commands | AutoFormat
Styles and Formatting > Blog Post | Styles | Styles

Styles and Formatting > Home | Styles | Styles

Reveal Formatting > Office Button | Word Options | Customize | Al Commands | Reveal
Object > Click the object, and then click the Ribbon tab with tools for that object

Microsoft Office Word 2007 - Command Reference Sheet
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Word: Tools

Word 2003 Location
Spelling and Grammar

Spelling and Grammar
Research

Research

Language (Set Language)
Language (Set Language)

* Language (Japanese Consistency
Checker)

* Language (Hangul Hanja
Conversion)

* Language (Hangul Hanja
Conversion)

* Language (Chinese Translation -
Translate with Options)

* Language (Chinese Translation -
Translate with Options)

Language (Translate)

Language (Translate)

Language (Thesaurus)
Language (Thesaurus)
Language (Hyphenation)

* Fix Broken Text

Word Count

Word Count

AutoSummarize

Look Up Reference

Speech

Shared Workspace

Track Changes

Compare and Merge Documents
Compare and Merge Documents
Protect Document

Protect Document

Online Collaboration (Meet Now)
Online Collaboration (Schedule

bnline Collaboration (Web
Discussions)

Online Collaboration (End Review)
Letters and Mailings (Mail Merge)

Letters and Mailings (Show Mail Merge
Toolbar)

* Letters and Mailings (Show
Japanese Greetings Toolbar)
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Word 2007 Location
Review | Proofing | Spelling & Grammar

Blog Post | Proofing | Spelling

Review | Proofing | Research

Blog Post | Proofing | Spelling | Research
Review | Proofing | Set Language

Blog Post | Proofing | Spelling | Set Language

Review | Proofing | Japanese Consistency Checker
Review | Proofing | Hangul Hanja Conversion

Blog Post | Proofing | Spelling | Hangul Hanja Conversion
Review | Chinese Translation | Translate with Options

Blog Post | Proofing | Spelling | Translate with Options

Review | Proofing | Translate

Blog Post | Proofing | Spelling | Translate

Review | Proofing | Thesaurus

Blog Post | Proofing | Spelling | Thesaurus

Page Layout | Page Setup | Hyphenation | Hyphenation Options
Available as a download from the Office Online Web site
Review | Proofing | Word Count

Blog Post | Proofing | Spelling | Word Count

Office Button | Word Options | Customize | All Commands | AutoSummary
Right-click in a word, and then click Look Up

Removed from product

File | Publish | Create Document W orkspace

Review | Tracking | Track Changes

Review | Compare | Compare | Compare

Review | Compare | Compare | Combine

Developer | Protect | Protect Document

Review | Protect | Protect Document

Removed from product

Removed from product

Removed from product

Removed from product

Mailings | Start Mail Merge | Start Mail Merge | Step by Step Mail Merge
Toolbars have been removed from the product.

To find commands on the Mail Merge toolbar, go to the Mail Merge Toolbar
sheet of this workbook.

Toolbars have been removed from the product.

To find commands on the Japanese Greetings toolbar, go to the Japanese
Greetings Toolbar sheet of this workbook.
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Word: Tools

Word 2003 Location

* | etters and Mailings (Japanese

Postcard Wizard)

Letters and Mailings (Envelopes and

Labels)

Letters and Mailings (Envelopes and

Labels)
* | etters and Mailings (Chinese
Envelope Wizard)

Letters and Mailings (Letter Wizard)

Macro (Macros)

Macro (Macros)

Macro (Record New Macro)
Macro (Record New Macro)
Macro (Security)

Macro (Visual Basic Editor)
Macro (Microsoft Script Editor)
Templates and Add-Ins
AutoCorrect Options
Customize

Show Signature

Options
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Mailings | Create | Japanese Postcard Wizard
Mailings | Create | Envelopes

Mailings | Create | Labels

Mailings | Create | Chinese Envelope

Removed from product

Developer | Code | Macros

View | Macros | Macros

Developer | Code | Record Macro / Stop Recorder
View | Macros | Macros | Record Macro / Stop Recorder
Developer | Code | Macro Security

Developer | Code | Visual Basic

Removed from product

Developer | Templates | Document Template

Office Button | Word Options | Proofing | AutoCorrect Options
Office Button | Word Options | Customize

Office Button | Finish | Add a Digital Signature

Office Button | Word Options
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Word: Table

Word 2003 Location
Draw Table

Draw Table
Draw Table
Draw Table
Insert (Table)

Insert (Columns to the Left)
Insert (Columns to the Right)
Insert (Rows Above)

Insert (Rows Below)

Insert (Cells)

Delete (Table)

Delete (Columns)

Delete (Rows)

Delete (Cells)

Select (Table)

Select (Column)

Select (Row)

Select (Cell)

Merge Cells

Split Cells

Split Table

Table AutoFormat

AutoFit (AutoFit to Contents)
AutoFit (AutoFit to Window)
AutoFit (Fixed Column Width)

AutoFit (Distribute Rows Evenly)

AutoFit (Distribute Columns Evenly)

Heading Rows Repeat

* Insert Multidiagonal Cell
Convert (Text to Table)
Convert (Table to Text)
Sort

Sort

Formula

Show Gridlines

Table Properties

Table Properties

Microsoft Office Word 2007 - Command Reference Sheet
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Word 2007 Location
Table Tools | Design | Draw Borders | Draw Table

Home | Paragraph | Borders | Draw Table

Insert | Tables | Table | Draw Table

Table Tools | Design | Table Styles | Borders | Draw Table
Insert | Tables | Table | Insert Table

Table Tools | Layout | Rows & Columns | Insert Left

Table Tools | Layout | Rows & Columns | Insert Right

Table Tools | Layout | Rows & Columns | Insert Above

Table Tools | Layout | Rows & Columns | Insert Below

Table Tools | Layout | Rows & Columns | Dialog Box Launcher
Table Tools | Layout | Rows & Columns | Delete | Delete Table
Table Tools | Layout | Rows & Columns | Delete | Delete Columns
Table Tools | Layout | Rows & Columns | Delete | Delete Rows
Table Tools | Layout | Rows & Columns | Delete | Delete Cells
Table Tools | Layout | Table | Select | Select Table

Table Tools | Layout | Table | Select | Select Column

Table Tools | Layout | Table | Select | Select Row

Table Tools | Layout | Table | Select | Select Cell

Table Tools | Layout | Merge | Merge Cells

Table Tools | Layout | Merge | Split Cells

Table Tools | Layout | Merge | Split Table

Table Tools | Design | Table Styles

Table Tools | Layout | Cell Size | AutoFit | AutoFit Contents
Table Tools | Layout | Cell Size | AutoFit | AutoFit Window
Table Tools | Layout | Cell Size | AutoFit | Fixed Column Width

Table Tools | Layout | Cell Size | Distribute Rows

Table Tools | Layout | Cell Size | Distribute Columns

Table Tools | Layout | Data | Repeat Header Rows
Table Tools | Layout | Table | Insert Multidiagonal Cell
Insert | Tables | Table | Convert Text to Table

Table Tools | Layout | Data | Convert to Text

Home | Paragraph | Sort

Table Tools | Layout | Data | Sort

Table Tools | Layout | Data | Formula

Table Tools | Layout | Table | Show Gridlines

Table Tools | Layout | Cell Size | Properties

Table Tools | Layout | Table | Properties
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Word: Window

Word 2003 Location
New Window

Arrange All
Compare Side by Side with
Split

Currently Open Documents

Microsoft Office Word 2007 - Command Reference Sheet

Word 2007 Location

View | Window | New Window
View | Window | Arrange All

View | Window | View Side by Side
View | Window | Split

View | Window | Switch Windows | Window Name Goes
Here
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Word: Help
Word 2003 Location
Microsoft Office Word Help

Show the Office Assistant
Microsoft Office Online
Contact Us

Check for Updates

Detect and Repair
Activate Product

Customer Feedback Options

About Microsoft Office Word

Microsoft Office Word 2007 - Command Reference Sheet

Word 2007 Location
> Upper Ribbon | Help
> Removed from product
> Office Button | Word Options | Resources | Microsoft Office Online
> Office Button | Word Options | Resources | Contact Us
> Office Button | Word Options | Resources | Check for Updates
> Office Button | Word Options | Resources | Diagnose
> Office Button | Word Options | Resources | Activate Product

Office Button | Word Options | Trust Center | Protecting Your Privacy |
Customer Experience Improvement Program

Office Button | Word Options | Resources | About

\%
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Word: Standard
Word 2003 Location Word 2007 Location

New Blank Document > Office Button | New | Blank Document

Open > Office Button | Open

Save > Quick Access Toolbar | Save

Save > Office Button | Save

Permission > Office Button | Prepare | Restrict Permission

E-mail Offi§e_ Button | Word Options | Customize | All Commands | Send to Mail
Recipient

Print > Office Button | Print | Quick Print

Print Preview > Office Button | Print | Print Preview

* Chinese Translation (Translate to
Simplified Chinese)
* Chinese Translation (Translate to
Simplified Chinese)
* Chinese Translation (Translate to

> Review | Chinese Translation | Simplified

> Blog Post | Proofing | Spelling | Simplified

Traditional Chinese) > Review | Chinese Translation | Traditional
T;Z::if};gﬁ?ﬂii‘)’” (Translateto b0 Post | Proofing | Spelling | Traditional

Spelling and Grammar > Blog Post | Proofing | Spelling & Grammar

Spelling and Grammar > Review | Proofing | Spelling & Grammar

Research > Review | Proofing | Research

Research > Blog Post | Proofing | Spelling | Research

Cut > Blog Post | Clipboard | Cut

Cut > Home | Clipboard | Cut

Copy > Blog Post | Clipboard | Copy

Copy > Home | Clipboard | Copy

Paste > Blog Post | Clipboard | Paste

Paste > Home | Clipboard | Paste

Format Painter > Blog Post | Clipboard | Format Painter

Format Painter > Home | Clipboard | Format Painter

Undo > Quick Access Toolbar | Undo

Redo > Quick Access Toolbar | Redo

Insert Ink Annotations > Review | Ink | Start Inking

Hyperlink > Insert | Links | Hyperlink

Tables and Borders Toolbar > Insert or select a table to see the Table Tools tab
Insert Table > Insert | Tables | Table

Insert Excel Spreadsheet > Insert | Tables | Table | Excel Spreadsheet

Columns > Page Layout | Page Setup | Columns | More Columns
Drawing > Insert or select a shape to see the Drawing Tools tab
Document Map > View | Show/Hide | Document Map

Show All > Blog Post | Basic Text | Show All

Show All > Home | Paragraph | Show All

Zoom > Status Bar | Zoom Slider

Microsoft Office Word Help > Microsoft Office Word Help (F1),"?" button at top of ribbon
Read > View | Document Views | Full Screen Reading

Microsoft Office Word 2007 - Command Reference Sheet
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Word: Standard

Word 2003 Location
Print

Print

Close

Envelopes and Labels
Envelopes and Labels

Envelopes and Labels

Find
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Word 2007 Location
Office Button | Print

Print Preview | Print | Print
Office Button | Close
Mailings | Create | Envelopes
Mailings | Create | Labels

Office Button | Word Options | Customize | All Commands | Envelope &
Label Wizard

Home | Editing | Find
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Word: Formatting

Word 2003 Location
Styles and Formatting

Styles and Formatting
Style

Font

Font

Font Size
Font Size
Keyboard Language
Bold

Bold

Italic

Italic
Underline
Underline
Align Left
Align Left
Center
Center

Align Right
Align Right
Justify

* Distributed
Line Spacing
* Left-to-Right
* Right-to-Left

* Keyboard Language Drop Down

* Character Border
* Character Shading
* Enclose Characters
Numbering
Numbering

Bullets

Bullets

Decrease Indent
Decrease Indent
Increase Indent
Increase Indent
Borders

Highlight

Highlight

Font Color

Font Color

Microsoft Office Word 2007 - Command Reference Sheet
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Word 2007 Location

Blog Post | Styles | Styles

Home | Styles | Styles

Home | Styles | Dialog Box Launcher
Blog Post | Basic Text | Font
Home | Font | Font

Blog Post | Basic Text | Font Size
Home | Font | Font Size

Use settings in Microsoft Windows to change the keyboard language
Blog Post | Basic Text | Bold
Home | Font | Bold

Blog Post | Basic Text | Italic
Home | Font | Italic

Home | Font | Underline

Blog Post | Basic Text | Underline
Blog Post | Basic Text | Align Left
Home | Paragraph | Align Left

Blog Post | Basic Text | Center
Home | Paragraph | Center

Blog Post | Basic Text | Align Right
Home | Paragraph | Align Right
Home | Paragraph | Justify

Home | Paragraph | Distributed
Home | Paragraph | Line spacing
Home | Paragraph | Left-to-Right
Home | Paragraph | Right-to-Left

Removed from product

Home | Font | Character Border

Home | Font | Character Shading
Home | Font | Enclose Characters

Blog Post | Basic Text | Numbering
Home | Paragraph | Numbering

Blog Post | Basic Text | Bullets

Home | Paragraph | Bullets

Blog Post | Basic Text | Decrease Indent
Home | Paragraph | Decrease Indent
Blog Post | Basic Text | Increase Indent
Home | Paragraph | Increase Indent
Home | Paragraph | Borders

Home | Font | Highlight

Blog Post | Basic Text | Highlight
Home | Font | Font Color

Blog Post | Basic Text | Font Color



nn Microsoft* %
. 2.Office Online
Word: Formatting

Word 2003 Location Word 2007 Location

Grow Font > Blog Post | Basic Text | Grow Font
Grow Font > Home | Font | Grow Font

Shrink Font > Blog Post | Basic Text | Shrink Font
Shrink Font > Home | Font | Shrink Font
Superscript > Home | Font | Superscript
Subscript > Home | Font | Subscript

Microsoft Office Word 2007 - Command Reference Sheet
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Word: AutoText

Word 2003 Location Word 2007 Location
AutoText > Insert | Text | Quick Parts | Building Blocks Organizer
All Entries > Insert | Text | Quick Parts | Building Blocks Organizer
Office Button | Word Options | Customize | All Commands | Create
New
AutoText

Microsoft Office Word 2007 - Command Reference Sheet
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Word: Control Toolbox

Word 2003 Location
Design Mode

Properties
View Code
Check Box
Text Box

Command Button

Option Button
List Box
Combo Box
Toggle Button
Spin Button
Scroll Bar
Label

Image

More Controls

Microsoft Office Word 2007 - Command Reference Sheet

A\

vV V VvV V V V V V V

Word 2007 Location
Developer | Controls | Design Mode

Developer | Controls | Properties

Developer | Code | Visual Basic

Developer | Controls | Legacy Tools | Check Box
Developer | Controls | Legacy Tools | Text Box

Developer | Controls | Legacy Tools | Command Button

Developer | Controls | Legacy Tools | Option Button
Developer | Controls | Legacy Tools | List Box
Developer | Controls | Legacy Tools | Combo Box
Developer | Controls | Legacy Tools | Toggle Button
Developer | Controls | Legacy Tools | Spin Button
Developer | Controls | Legacy Tools | Scroll Bar
Developer | Controls | Legacy Tools | Label
Developer | Controls | Legacy Tools | Image

Developer | Controls | Legacy Tools | More Controls
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Word: Database

Word 2003 Location
Data Form

Manage Fields
Add Record

Delete Record
Sort Ascending
Sort Descending

Database

Update Field
Find in Field

Main Document

Microsoft Office Word 2007 - Command Reference Sheet

Word 2007 Location
Office Button | Word Options | Customize | All Commands | Data Form

Office Button | Word Options | Customize | All Commands | Manage
Office Button | Word Options | Customize | All Commands | Add

Office Button | Word Options | Customize | All Commands | Delete Record
Office Button | Word Options | Customize | All Commands | Sort Ascending
Office Button | Word Options | Customize | All Commands | Sort Descending

Office Button | Word Options | Customize | All Commands | Insert Database

Office Button | Word Options | Customize | All Commands | Update
Office Button | Word Options | Customize | All Commands | Find

Office Button | Word Options | Customize | All Commands | Mail Merge
Document
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Word: Drawing

Word 2003 Location
Draw (Group)

Draw (Group)

Draw (Group)

Draw (Group)

Draw (Group)

Draw (Group)

Draw (Group)

Draw (Group)

Draw (Group)

Draw (Ungroup)

Draw (Ungroup)

Draw (Ungroup)

Draw (Ungroup)

Draw (Ungroup)

Draw (Ungroup)

Draw (Ungroup)

Draw (Ungroup)

Draw (Ungroup)

Draw (Regroup)

Draw (Regroup)

Draw (Regroup)

Draw (Regroup)

Draw (Regroup)

Draw (Regroup)

Draw (Regroup)

Draw (Regroup)

Draw (Regroup)

Draw (Order - Bring to Front)
Draw (Order - Bring to Front)
Draw (Order - Bring to Front)
Draw (Order - Bring to Front)
Draw (Order - Bring to Front)
Draw (Order - Bring to Front)
Draw (Order - Bring to Front)
Draw (Order - Bring to Front)
Draw (Order - Bring to Front)
Draw (Order - Send to Back)
Draw (Order - Send to Back)
Draw (Order - Send to Back)
Draw (Order - Send to Back)
Draw (Order - Send to Back)
Draw (Order - Send to Back)

Microsoft Office Word 2007 - Command Reference Sheet

V V vV vV V V VvV Vv V V V V

Vv

Word 2007 Location
Page Layout | Arrange | Group | Group

Drawing Tools | Format | Arrange | Group | Group
Organization Chart Tools | Format | Arrange | Group | Group
Chart Tools | Format | Arrange | Group | Group

Diagram Tools | Format | Arrange | Group | Group
SmartArt Tools | Format | Arrange | Group | Group

Picture Tools | Format | Arrange | Group | Group

WordArt Tools | Format | Arrange | Group | Group

Text Box Tools | Format | Arrange | Group | Group

Page Layout | Arrange | Group | Ungroup

Drawing Tools | Format | Arrange | Group | Ungroup
Organization Chart Tools | Format | Arrange | Group | Ungroup
Chart Tools | Format | Arrange | Group | Ungroup

Diagram Tools | Format | Arrange | Group | Ungroup
SmartArt Tools | Format | Arrange | Group | Ungroup
Picture Tools | Format | Arrange | Group | Ungroup
WordArt Tools | Format | Arrange | Group | Ungroup

Text Box Tools | Format | Arrange | Group | Ungroup

Page Layout | Arrange | Group | Regroup

Drawing Tools | Format | Arrange | Group | Regroup
Organization Chart Tools | Format | Arrange | Group | Regroup
Chart Tools | Format | Arrange | Group | Regroup

Diagram Tools | Format | Arrange | Group | Regroup
SmartArt Tools | Format | Arrange | Group | Regroup
Picture Tools | Format | Arrange | Group | Regroup
WordArt Tools | Format | Arrange | Group | Regroup

Text Box Tools | Format | Arrange | Group | Regroup

Page Layout | Arrange | Bring to Front

Drawing Tools | Format | Arrange | Bring to Front
Organization Chart Tools | Format | Arrange | Bring to Front
Chart Tools | Format | Arrange | Bring to Front

Diagram Tools | Format | Arrange | Bring to Front

SmartArt Tools | Format | Arrange | Bring to Front

Picture Tools | Format | Arrange | Bring to Front

WordArt Tools | Format | Arrange | Bring to Front

Text Box Tools | Format | Arrange | Bring to Front

Page Layout | Arrange | Send to Back

Drawing Tools | Format | Arrange | Send to Back
Organization Chart Tools | Format | Arrange | Send to Back
Chart Tools | Format | Arrange | Send to Back

Diagram Tools | Format | Arrange | Send to Back

SmartArt Tools | Format | Arrange | Send to Back
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Word: Drawing

Word 2003 Location
Draw (Order - Send to Back)

Draw (Order - Send to Back)
Draw (Order - Send to Back)
Draw (Order - Bring Forward)

Draw (Order - Bring Forward)
Draw (Order - Bring Forward)

Draw (Order - Bring Forward)
Draw (Order - Bring Forward)
Draw (Order - Bring Forward)
Draw (Order - Bring Forward)
Draw (Order - Bring Forward)
Draw (Order - Bring Forward)
Draw (Order - Send Backward)
Draw (Order - Send Backward)

Draw (Order - Send Backward)

Draw (Order - Send Backward)
Draw (Order - Send Backward)

Draw (Order - Send Backward)

Draw (Order - Send Backward)
Draw (Order - Send Backward)

Draw (Order - Send Backward)

Draw (Order - Bring in Front of Text)
Draw (Order - Bring in Front of Text)
Draw (Order - Bring in Front of Text)
Draw (Order - Bring in Front of Text)
Draw (Order - Bring in Front of Text)
Draw (Order - Bring in Front of Text)
Draw (Order - Bring in Front of Text)
Draw (Order - Bring in Front of Text)
Draw (Order - Bring in Front of Text)

Draw (Order - Send Behind Text)
Draw (Order - Send Behind Text)
Draw (Order - Send Behind Text)

Draw (Order - Send Behind Text)

Microsoft Office Word 2007 - Command Reference Sheet
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Word 2007 Location
Picture Tools | Format | Arrange | Send to Back

WordArt Tools | Format | Arrange | Send to Back

Text Box Tools | Format | Arrange | Send to Back

Page Layout | Arrange | Bring to Front | Bring Forward

Drawing Tools | Format | Arrange | Bring to Front | Bring Forward

Organization Chart Tools | Format | Arrange | Bring to Front | Bring Forward

Chart Tools | Format | Arrange | Bring to Front | Bring Forward
Diagram Tools | Format | Arrange | Bring to Front | Bring Forward
SmartArt Tools | Format | Arrange | Bring to Front | Bring Forward
Picture Tools | Format | Arrange | Bring to Front | Bring Forward
WordArt Tools | Format | Arrange | Bring to Front | Bring Forward
Text Box Tools | Format | Arrange | Bring to Front | Bring Forward
Page Layout | Arrange | Send to Back | Send Backward

Drawing Tools | Format | Arrange | Send to Back | Send Backward

Organization Chart Tools | Format | Arrange | Send to Back | Send
Backward

Chart Tools | Format | Arrange | Send to Back | Send Backward

Diagram Tools | Format | Arrange | Send to Back | Send Backward
SmartArt Tools | Format | Arrange | Send to Back | Send Backward

Picture Tools | Format | Arrange | Send to Back | Send Backward
WordArt Tools | Format | Arrange | Send to Back | Send Backward

Text Box Tools | Format | Arrange | Send to Back | Send Backward

Organization Chart Tools | Format | Arrange | Bring to Front | Bring in Front
of Text

Diagram Tools | Format | Arrange | Bring to Front | Bring in Front of Text
WordArt Tools | Format | Arrange | Bring to Front | Bring in Front of Text
Drawing Tools | Format | Arrange | Bring to Front | Bring in Front of Text
Picture Tools | Format | Arrange | Bring to Front | Bring in Front of Text
SmartArt Tools | Format | Arrange | Bring to Front | Bring in Front of Text
Chart Tools | Format | Arrange | Bring to Front | Bring in Front of Text
Page Layout | Arrange | Bring to Front | Bring in Front of Text

Text Box Tools | Format | Arrange | Bring to Front | Bring in Front of Text

Text Box Tools | Format | Arrange | Send to Back | Send Behind Text
Page Layout | Arrange | Send to Back | Send Behind Text
SmartArt Tools | Format | Arrange | Send to Back | Send Behind Text

Picture Tools | Format | Arrange | Send to Back | Send Behind Text
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Word: Drawing
Word 2003 Location
Draw (Order - Send Behind Text)

Draw (Order - Send Behind Text)
Draw (Order - Send Behind Text)

Draw (Order - Send Behind Text)

Draw (Order - Send Behind Text)
Draw (Grid)
Draw (Grid)
Draw (Grid)
Draw (Grid)
Draw (Grid)
Draw (Grid)
Draw (Grid)
Draw (Grid)
Draw (Grid)
Draw (Nudge)

Draw (Nudge - Up)
Draw (Nudge - Down)
Draw (Nudge - Left)

Draw (Nudge - Right)

Draw (Align or Distribute)
Draw (Align or Distribute)
Draw (Align or Distribute)
Draw (Align or Distribute)
Draw (Align or Distribute)
Draw (Align or Distribute)

Draw (Align or Distribute - Align Left)
Draw (Align or Distribute - Align Left)
Draw (Align or Distribute - Align Left)
Draw (Align or Distribute - Align Left)
Draw (Align or Distribute - Align Left)

Draw (Align or Distribute - Align Left)

Draw (Align or Distribute - Align
Center)
Draw (Align or Distribute - Align
Center)

Microsoft Office Word 2007 - Command Reference Sheet
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Word 2007 Location
Chart Tools | Format | Arrange | Send to Back | Send Behind Text

Drawing Tools | Format | Arrange | Send to Back | Send Behind Text
WordArt Tools | Format | Arrange | Send to Back | Send Behind Text

Diagram Tools | Format | Arrange | Send to Back | Send Behind Text
Organization Chart Tools | Format | Arrange | Send to Back | Send Behind
Page Layout | Arrange | Align | Grid Settings

Drawing Tools | Format | Arrange | Align | Grid Settings
Organization Chart Tools | Format | Arrange | Align | Grid Settings
Chart Tools | Format | Arrange | Align | Grid Settings

Diagram Tools | Format | Arrange | Align | Grid Settings

SmartArt Tools | Format | Arrange | Align | Grid Settings

Picture Tools | Format | Arrange | Align | Grid Settings

WordArt Tools | Format | Arrange | Align | Grid Settings

Text Box Tools | Format | Arrange | Align | Grid Settings

Office Button | Word Options | Customize | All Commands | Nudge

Office Button | Word Options | Customize | All Commands | Nudge | Up
Office Button | Word Options | Customize | All Commands | Nudge | Down
Office Button | Word Options | Customize | All Commands | Nudge | Left

Office Button | Word Options | Customize | All Commands | Nudge | Right

SmartArt Tools | Format | Arrange | Align
Chart Tools | Format | Arrange | Align

Drawing Tools | Format | Arrange | Align
WordArt Tools | Format | Arrange | Align
Diagram Tools | Format | Arrange | Align

Organization Chart Tools | Format | Arrange | Align

SmartArt Tools | Format | Arrange | Align Left

Chart Tools | Format | Arrange | Align Left

Drawing Tools | Format | Arrange | Align Left

WordArt Tools | Format | Arrange | Align Left

Diagram Tools | Format | Arrange | Align Left
Organization Chart Tools | Format | Arrange | Align Left
SmartArt Tools | Format | Arrange | Align Center

Chart Tools | Format | Arrange | Align Center
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Word: Drawing

Word 2003 Location Word 2007 Location

Draw (Align or Distribute - Align > Drawing Tools | Format | Arrange | Align Center

Center)

Draw (Align or Distribute - Align > WordArt Tools | Format | Arrange | Align Center

Center)

PIESI YGRS/ T > Diagram Tools | Format | Arrange | Align Center

Center)

g;ivtveifhgn or Distribute - Align > Organization Chart Tools | Format | Arrange | Align Center

Draw (Align or Distribute - Align Right) > SmartArt Tools | Format | Arrange | Align Right

Draw (Align or Distribute - Align Right) > Chart Tools | Format | Arrange | Align Right

Draw (Align or Distribute - Align Right) > Drawing Tools | Format | Arrange | Align Right

Draw (Align or Distribute - Align Right) > WordArt Tools | Format | Arrange | Align Right

Draw (Align or Distribute - Align Right) > Diagram Tools | Format | Arrange | Align Right

Draw (Align or Distribute - Align Right) > Organization Chart Tools | Format | Arrange | Align Right
Draw (Align or Distribute - Align Top) > SmartArt Tools | Format | Arrange | Align Top

Draw (Align or Distribute - Align Top) > Chart Tools | Format | Arrange | Align Top

Draw (Align or Distribute - Align Top) > Drawing Tools | Format | Arrange | Align Top

Draw (Align or Distribute - Align Top) > WordArt Tools | Format | Arrange | Align Top

Draw (Align or Distribute - Align Top) > Diagram Tools | Format | Arrange | Align Top

Draw (Align or Distribute - Align Top) > Organization Chart Tools | Format | Arrange | Align Top

Draw (Align or Distribute - Align > SmartArt Tools | Format | Arrange | Align Middle

Middle)

Draw (Align or Distribute - Align > Chart Tools | Format | Arrange | Align Middle
Middle)

Dfa"" (Align or Distribute - Align > Drawing Tools | Format | Arrange | Align Middle
Middle)

Dfa"" (Align or Distribute - Align > WordArt Tools | Format | Arrange | Align Middle
Middle)

Dl.'aw (Align or Distribute - Align > Diagram Tools | Format | Arrange | Align Middle
Middle)

azz\évlé)Allgn or Distribute - Align > OQOrganization Chart Tools | Format | Arrange | Align Middle
Draw (Align or Distribute - Align > SmartArt Tools | Format | Arrange | Align Bottom
Bottom)

Draw (Align or Distribute - Align > Chart Tools | Format | Arrange | Align Bottom
Bottom)

Draw (Align or Distribute - Align > Drawing Tools | Format | Arrange | Align Bottom
Bottom)

Draw (Align or Distribute - Align > WordArt Tools | Format | Arrange | Align Bottom
Bottom)

gg?t\glrfs“gn or Distribute - Align > Diagram Tools | Format | Arrange | Align Bottom

Microsoft Office Word 2007 - Command Reference Sheet
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Word: Drawing

Word 2003 Location

Draw (Align or Distribute - Align
Bottom)

Draw (Align or Distribute - Distribute
Horizontally)

Draw (Align or Distribute - Distribute
Horizontally)

Draw (Align or Distribute - Distribute
Horizontally)

Draw (Align or Distribute - Distribute
Horizontally)

Draw (Align or Distribute - Distribute
Horizontally)

Draw (Align or Distribute - Distribute
Horizontally)

Draw (Align or Distribute - Distribute
Vertically)

Draw (Align or Distribute - Distribute
Vertically)

Draw (Align or Distribute - Distribute
Vertically)

Draw (Align or Distribute - Distribute
Vertically)

Draw (Align or Distribute - Distribute
Vertically)

Draw (Align or Distribute - Distribute
Vertically)

Draw (Align or Distribute - Relative to
Page)

Draw (Align or Distribute - Relative to
Page)

Draw (Align or Distribute - Relative to
Page)

Draw (Align or Distribute - Relative to
Page)

Draw (Align or Distribute - Relative to
Page)

Draw (Align or Distribute - Relative to
Page)

Draw (Align or Distribute - Relative to
Canvas)

Draw (Align or Distribute - Relative to
Canvas)

Draw (Align or Distribute - Relative to
Organization Chart)

Draw (Align or Distribute - Relative to
Organization Chart)

Draw (Align or Distribute - Relative to
Organization Chart)

Draw (Align or Distribute - Relative to
Diagram)

Draw (Align or Distribute - Relative to
Diagram)

Draw (Align or Distribute - Relative to
Diagram)

Microsoft Office Word 2007 - Command Reference Sheet

Word 2007 Location

Organization Chart Tools | Format | Arrange | Align Bottom
SmartArt Tools | Format | Arrange | Distribute Horizontally

Chart Tools | Format | Arrange | Distribute Horizontally

Drawing Tools | Format | Arrange | Distribute Horizontally
WordArt Tools | Format | Arrange | Distribute Horizontally
Diagram Tools | Format | Arrange | Distribute Horizontally
Organization Chart Tools | Format | Arrange | Distribute Horizontally
SmartArt Tools | Format | Arrange | Distribute Vertically

Chart Tools | Format | Arrange | Distribute Vertically

Drawing Tools | Format | Arrange | Distribute Vertically

WordArt Tools | Format | Arrange | Distribute Vertically

Diagram Tools | Format | Arrange | Distribute Vertically
Organization Chart Tools | Format | Arrange | Distribute Vertically
SmartArt Tools | Format | Arrange | Align to Page

Chart Tools | Format | Arrange | Align to Page

Drawing Tools | Format | Arrange | Align to Page

WordArt Tools | Format | Arrange | Align to Page

Diagram Tools | Format | Arrange | Align to Page

Organization Chart Tools | Format | Arrange | Align to Page
Drawing Tools | Format | Arrange | Align to Canvas

WordArt Tools | Format | Arrange | Align to Canvas

Drawing Tools | Format | Arrange | Align to Organization Chart
WordArt Tools | Format | Arrange | Align to Organization Chart
Organization Chart Tools | Format | Arrange | Align to Organization Chart
Drawing Tools | Format | Arrange | Align to Diagram

WordArt Tools | Format | Arrange | Align to Diagram

Diagram Tools | Format | Arrange | Align to Diagram
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Word: Drawing

Word 2003 Location

Draw (Rotate or Flip - Free Rotate)

Draw (Rotate or Flip - Rotate Left 90°)
Draw (Rotate or Flip - Rotate Left 90°)
Draw (Rotate or Flip - Rotate Left 90°)
Draw (Rotate or Flip - Rotate Left 90°)
Draw (Rotate or Flip - Rotate Left 90°)
Draw (Rotate or Flip - Rotate Left 90°)

Draw (Rotate or Flip - Rotate Left 90°)
Draw (Rotate or Flip - Rotate Right
90°)

Draw (Rotate or Flip - Rotate Right
90°)

Draw (Rotate or Flip - Rotate Right
90°)

Draw (Rotate or Flip - Rotate Right
90°)

Draw (Rotate or Flip - Rotate Right
90°)

Draw (Rotate or Flip - Rotate Right
90°)

Draw (Rotate or Flip - Rotate Right
90°)

Draw (Rotate or Flip - Flip Horizontal)
Draw (Rotate or Flip - Flip Horizontal)
Draw (Rotate or Flip - Flip Horizontal)
Draw (Rotate or Flip - Flip Horizontal)
Draw (Rotate or Flip - Flip Horizontal)
Draw (Rotate or Flip - Flip Horizontal)
Draw (Rotate or Flip - Flip Horizontal)
Draw (Rotate or Flip - Flip Vertical)
Draw (Rotate or Flip - Flip Vertical)
Draw (Rotate or Flip - Flip Vertical)
Draw (Rotate or Flip - Flip Vertical)

Draw (Rotate or Flip - Flip Vertical)

Microsoft Office Word 2007 - Command Reference Sheet

Word 2007 Location

Click object, select green anchor, and drag to rotate freely
Page Layout | Arrange | Rotate | Rotate Left 90°

Drawing Tools | Format | Arrange | Rotate | Rotate Left 90°
Chart Tools | Format | Arrange | Rotate | Rotate Left 90°
SmartArt Tools | Format | Arrange | Rotate | Rotate Left 90°
Picture Tools | Format | Arrange | Rotate | Rotate Left 90°
WordArt Tools | Format | Arrange | Rotate | Rotate Left 90°
Text Box Tools | Format | Arrange | Rotate | Rotate Left 90°
Page Layout | Arrange | Rotate | Rotate Right 90°

Drawing Tools | Format | Arrange | Rotate | Rotate Right 90°
Chart Tools | Format | Arrange | Rotate | Rotate Right 90°
SmartArt Tools | Format | Arrange | Rotate | Rotate Right 90°
Picture Tools | Format | Arrange | Rotate | Rotate Right 90°
WordArt Tools | Format | Arrange | Rotate | Rotate Right 90°
Text Box Tools | Format | Arrange | Rotate | Rotate Right 90°
Page Layout | Arrange | Rotate | Flip Horizontal

Drawing Tools | Format | Arrange | Rotate | Flip Horizontal
Chart Tools | Format | Arrange | Rotate | Flip Horizontal
SmartArt Tools | Format | Arrange | Rotate | Flip Horizontal
Picture Tools | Format | Arrange | Rotate | Flip Horizontal
WordArt Tools | Format | Arrange | Rotate | Flip Horizontal
Text Box Tools | Format | Arrange | Rotate | Flip Horizontal
Page Layout | Arrange | Rotate | Flip Vertical

Drawing Tools | Format | Arrange | Rotate | Flip Vertical
Chart Tools | Format | Arrange | Rotate | Flip Vertical
SmartArt Tools | Format | Arrange | Rotate | Flip Vertical

Picture Tools | Format | Arrange | Rotate | Flip Vertical
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Word: Drawing

Word 2003 Location

Draw (Rotate or Flip - Flip Vertical)

Draw (Rotate or Flip - Flip Vertical)

Draw (Text Wrapping)
Draw (Text Wrapping)
Draw (Text Wrapping)
Draw (Text Wrapping)
Draw (Text Wrapping)
Draw (Text Wrapping)
Draw (Text Wrapping)
Draw (Text Wrapping)
Draw (Text Wrapping)

Draw (Reroute Connectors)

Draw (Edit Points)
Draw (Change AutoShape)
Draw (Change AutoShape)

Draw (Set AutoShape Defaults)

Select Objects
Select Objects
AutoShapes
AutoShapes
AutoShapes (More AutoShapes)
Line

Line

Arrow

Arrow

Rectangle
Rectangle

Oval

Oval

Text Box

Text Box

Text Box

* Vertical Text Box

* Vertical Text Box

* Vertical Text Box

WordArt
Diagram
Clip Art
Clip Art

Microsoft Office Word 2007 - Command Reference Sheet

\

vV V Vv V V V

Word 2007 Location

WordArt Tools | Format | Arrange | Rotate | Flip Vertical

Text Box Tools | Format | Arrange | Rotate | Flip Vertical

WordArt Tools | Format | Arrange | Text Wrapping

Drawing Tools | Format | Arrange | Text Wrapping

Chart Tools | Format | Arrange | Text Wrapping

Picture Tools | Picture Tools | Arrange | Text Wrapping
SmartArt Tools | Format | Arrange | Text Wrapping

Page Layout | Arrange | Text Wrapping

Text Box Tools | Format | Arrange | Text Wrapping

Diagram Tools | Format | Arrange | Text Wrapping
Organization Chart Tools | Format | Arrange | Text Wrapping

Drawing Tools | Format | Insert Shapes | Edit Shape | Reroute Connectors

Drawing Tools | Format | Insert Shapes | Edit Shape | Edit Points
Drawing Tools | Format | Shape Styles | Change Shape
Text Box Tools | Format | Text Box Styles | Change Shape

Office Button | Word Options | Customize | All Commands | Set AutoShape
Defaults

Ink Tools | Pens | Select | Select Objects

Home | Editing | Select | Select Objects

Insert | lllustrations | Shapes

Drawing Tools | Format | Insert Shapes

Insert | Clip Art

Insert | lllustrations | Shapes

Drawing Tools | Format | Insert Shapes

Insert | lllustrations | Shapes

Drawing Tools | Format | Insert Shapes

Insert | lllustrations | Shapes

Drawing Tools | Format | Insert Shapes

Insert | lllustrations | Shapes

Drawing Tools | Format | Insert Shapes

Insert | Text | Text Box | Draw Text Box

Chart Tools | Layout | Insert | Draw Text Box | Draw Text Box
Text Box Tools | Format | Text | Draw Text Box | Draw Text Box
Insert | Text | Text Box | Draw Vertical Text Box

Chart Tools | Layout | Insert | Draw Text Box | Draw Vertical Text Box

Text Box Tools | Format | Text | Draw Text Box | Draw Vertical Text Box

Insert | Text | WordArt
Insert | lllustrations | SmartArt
Insert | lllustrations | Clip Art

Header & Footer Tools | Design | Insert | Clip Art
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Word: Drawing

Word 2003 Location
Picture

Picture
Picture

Ink Drawing and Writing
Fill Color
Fill Color
Fill Color
Fill Color
Fill Color
Fill Color
Fill Color
Line Color
Line Color
Line Color
Line Color
Line Color
Line Color
Line Color
Font Color
Line Style
Line Style
Line Style
Line Style
Line Style
Line Style
Line Style
Dash Style
Dash Style
Dash Style
Dash Style
Dash Style
Dash Style
Dash Style

Arrow Style

Arrow Style
Arrow Style
Arrow Style
Arrow Style
Arrow Style
Arrow Style

Shadow Style

Microsoft Office Word 2007 - Command Reference Sheet

V V VvV vV VvV V V Vv V V V V V V

Vv

Word 2007 Location

Insert | lllustrations | Picture

Header & Footer Tools | Design | Insert | Picture

Chart Tools | Layout | Insert | Picture

Review | Ink | Start Inking

Organization Chart Tools | Format | Styles | Shape Fill

Text Box Tools | Format | Text Box Styles | Shape Fill

SmartArt Tools | Format | Shape Styles | Shape Fill

Chart Tools | Format | Shape Styles | Shape Fill

Drawing Tools | Format | Shape Styles | Shape Fill

WordArt Tools | Format | WordArt Styles | Shape Fill

Diagram Tools | Format | Styles | Shape Fill

Organization Chart Tools | Format | Styles | Shape Outline

Text Box Tools | Format | Text Box Styles | Shape Outline
SmartArt Tools | Format | Shape Styles | Shape Outline

Chart Tools | Format | Shape Styles | Shape Outline

Drawing Tools | Format | Shape Styles | Shape Outline

WordArt Tools | Format | WordArt Styles | Shape Outline

Diagram Tools | Format | Styles | Shape Outline

Home | Font | Font Color

Organization Chart Tools | Format | Styles | Shape Outline | Weight
Text Box Tools | Format | Text Box Styles | Shape Outline | Weight
SmartArt Tools | Format | Shape Styles | Shape Outline | Weight
Chart Tools | Format | Shape Styles | Shape Outline | Weight
Drawing Tools | Format | Shape Styles | Shape Outline | Weight
WordArt Tools | Format | WordArt Styles | Shape Outline | Weight
Diagram Tools | Format | Styles | Shape Outline | W eight
Organization Chart Tools | Format | Styles | Shape Outline | Dashes
Text Box Tools | Format | Text Box Styles | Shape Outline | Dashes
SmartArt Tools | Format | Shape Styles | Shape Outline | Dashes
Chart Tools | Format | Shape Styles | Shape Outline | Dashes
Drawing Tools | Format | Shape Styles | Shape Outline | Dashes
WordArt Tools | Format | WordArt Styles | Shape Outline | Dashes
Diagram Tools | Format | Styles | Shape Outline | Dashes

Organization Chart Tools | Format | Styles | Shape Outline | Arrows

Text Box Tools | Format | Text Box Styles | Shape Outline | Arrows
SmartArt Tools | Format | Shape Styles | Shape Outline | Arrows
Chart Tools | Format | Shape Styles | Shape Outline | Arrows
Drawing Tools | Format | Shape Styles | Shape Outline | Arrows
WordArt Tools | Format | WordArt Styles | Shape Outline | Arrows

Diagram Tools | Format | Styles | Shape Outline | Arrows

Organization Chart Tools | Format | Shadow Effects | Shadow Effects
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Word: Drawing

Word 2003 Location
Shadow Style

Shadow Style
Shadow Style
Shadow Style
Shadow Style
Shadow Style

Shadow Style

3-D Style
3-D Style

3-D Style

3-D Style
3-D Style
3-D Style

3-D Style

Select Multiple Objects

Microsoft Office Word 2007 - Command Reference Sheet

\%

vV VvV V V

Word 2007 Location
Text Box Tools | Format | Shadow Effects | Shadow Effects

SmartArt Tools | Format | Shape Styles | Shape Effects | Shadow
Chart Tools | Format | Shape Styles | Shape Effects | Shadow
Drawing Tools | Format | Shadow Effects | Shadow Effects
WordArt Tools | Format | Shadow Effects | Shadow Effects
Diagram Tools | Format | Shadow Effects | Shadow Effects

Picture Tools | Format | Picture Styles | Picture Effects | Shadow Effects

Organization Chart Tools | Format | 3-D Effects | 3-D Effects
Text Box Tools | Format | 3-D Effects | 3-D Effects

SmartArt Tools | Format | Shape Styles | Shape Effects | 3-D Rotation

Drawing Tools | Format | 3-D Effects | 3-D Effects
WordArt Tools | Format | 3-D Effects | 3-D Effects
Diagram Tools | Format | 3-D Effects | 3-D Effects

Picture Tools | Format | Picture Styles | Picture Effects | 3-D Rotation

Office Button | Word Options | Customize | All Commands | Select Multiple
Objects
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Word 2003 Location
Drawing and Writing Pen

Save

Save

Print

Cut

Cut

Copy

Copy

Paste

Paste

Paste

Font

Font

Font Size

Font Size

Font Color
Font Color
Bold

Bold

Italic

Italic

Underline
Underline

Align Left

Align Left
Center

Center

Align Right
Align Right

* Distributed

* Left-to-Right
* Right - to-Left
Numbering
Numbering
Bullets

Bullets
Decrease Indent
Decrease Indent
Increase Indent
Increase Indent

Translate

Microsoft Office Word 2007 - Command Reference Sheet
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Word 2007 Location
Review | Ink | Start Inking

Quick Access Toolbar | Save
Office Button | Save

Office Button | Print | Quick Print
Blog Post | Clipboard | Cut

Home | Clipboard | Cut

Blog Post | Clipboard | Copy

Home | Clipboard | Copy

Blog Post | Clipboard | Paste

Home | Clipboard | Paste

Home | Clipboard | Paste | Paste
Blog Post | Basic Text | Font

Home | Font | Font

Blog Post | Basic Text | Font Size
Home | Font | Font Size

Blog Post | Basic Text | Font Color
Home | Font | Font Color

Blog Post | Basic Text | Bold

Home | Font | Bold

Blog Post | Basic Text | Italic

Home | Font | Italic

Blog Post | Basic Text | Underline
Home | Font | Underline

Blog Post | Basic Text | Align Left
Home | Paragraph | Align Left

Blog Post | Basic Text | Center
Home | Paragraph | Center

Blog Post | Basic Text | Align Right
Home | Paragraph | Align Right
Home | Paragraph | Distributed
Home | Paragraph | Left-to-Right
Home | Paragraph | Right-to-Left
Blog Post | Basic Text | Numbering
Home | Paragraph | Numbering
Blog Post | Basic Text | Bullets
Home | Paragraph | Bullets

Blog Post | Basic Text | Decrease Indent
Home | Paragraph | Decrease Indent
Blog Post | Basic Text | Increase Indent
Home | Paragraph | Increase Indent

Review | Proofing | Translate
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Word: Extended Formatting

Word 2003 Location
Highlight
* Enclose Characters

\%

* Phonetic Guide

* Dot Accent

* Double Strikethrough
* Combine Characters
Single Spacing

1.5 Spacing

Double Spacing

V VvV V VvV V V V V V

Columns

Microsoft Office Word 2007 - Command Reference Sheet

Word 2007 Location

Home | Font | Text Highlight Color

Home | Font | Enclose Characters

Home | Font | Phonetic Guide

Home | Font | Dialog Box Launcher

Home | Font | Dialog Box Launcher

Home | Paragraph | Asian Layout | Combine Characters
Home | Paragraph | Line spacing | 1.0

Home | Paragraph | Line spacing | 1.5

Home | Paragraph | Line spacing | 2.0

Page Layout | Page Setup | Columns | More Columns
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Word: Forms
Word 2003 Location
Text Form Field

Check Box
Combo Box
Properties
Draw Table
Draw Table
Draw Table

Draw Table

Insert Table
Frame

Show Field Shading
Reset Form Fields

Protect Form

Microsoft Office Word 2007 - Command Reference Sheet

Word 2007 Location
> Developer | Controls | Legacy Tools | Text Form Field

> Developer | Controls | Legacy Tools | Check Box
Developer | Controls | Legacy Tools | Combo Box
Developer | Controls | Properties

>
>
> Table Tools | Design | Draw Borders | Draw Table
> Home | Paragraph | Borders | Draw Table

>

Insert | Tables | Table | Draw Table

> Table Tools | Design | Table Styles | Borders | Draw Table
> Insert | Tables | Table
> Developer | Controls | Legacy Tools | Insert Frame

\%

Developer | Controls | Legacy Tools | Form Field Shading

\%

Developer | Controls | Legacy Tools | Reset Form Fields

Office Button | Word Options | Customize | All Commands |
Lock
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Word: Frames

Word 2003 Location

Table of Contents in Frame
New Frame Left

New Frame Right

New Frame Above
New Frame Below

Delete Frame

Frame Properties

Microsoft Office Word 2007 - Command Reference Sheet

Word 2007 Location
Office Button | Word Options | Customize | All Commands | Frames | Table
of Contents in Frame

Office Button | Word Options | Customize | All Commands | New Frame Left

Office Button | Word Options | Customize | All Commands | New Frame
Right
Office Button | Word Options | Customize | All Commands | New Frame

é).ffice Button | Word Options | Customize | All Commands | New Frame

Office Button | Word Options | Customize | All Commands | Delete Frame

Office Button | Word Options | Customize | All Commands | Frame
Properties
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Word: Function Key Display

Word 2003 Location
Help

Move Text
Insert AutoText
Repeat

GoTo

Other Pane
Spelling and Grammar
Function Key 8
Update Field
Menu Mode
Next Field
Save As

Microsoft Office Word 2007 - Command Reference Sheet
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Word 2007 Location
(F1) Help

(F2) Move Text

(F3) Insert Autotext
(F4) Repeat

(F5) GoTo

(F6) Other Pane

(F7) Spelling and Grammar

(F8) Selection
(F9) Update Field
(F10) Menu Mode
(F11) Next Field
(F12) Save As
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Word: Ink Annotations
Word 2003 Location
Annotation Pen

Eraser

Select Objects
Select Objects
Line Color
Line Style
Markup

Stop Erasing

Microsoft Office Word 2007 - Command Reference Sheet

Word 2007 Location

Review | Ink | Start Inking

Ink Tools | Pens | Eraser

Ink Tools | Pens | Select | Select Objects
Home | Editing | Select | Select Objects

Ink Tools | Format | Color

Ink Tools | Format | Weight

Review | Tracking | Show Markup | Ink
Select a different writing tool to stop erasing
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Word: Ink Drawing and Writing

Word 2003 Location
Drawing and Writing Pen

Eraser

Select Objects
Select Objects
Line Color
Line Style
Stop Erasing

Microsoft Office Word 2007 - Command Reference Sheet
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Word 2007 Location
Ink Tools | Pens

Ink Tools | Pens | Eraser

Ink Tools | Pens | Select | Select Objects
Home | Editing | Select | Select Objects

Ink Tools | Format | Color

Ink Tools | Format | Weight

Select a different writing tool to stop erasing
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Word: Japanese Greetings

Word 2003 Location
* Greeting

* Greeting
* Opening
* Opening

* Closing
* Closing
* Insert Previous Greeting

Microsoft Office Word 2007 - Command Reference Sheet
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Word 2007 Location

Insert | Text | Japanese Greetings | Greeting
Mailings | Create | Japanese Greetings | Greeting
Insert | Text | Japanese Greetings | Opening
Mailings | Create | Japanese Greetings | Opening

Insert | Text | Japanese Greetings | Closing
Mailings | Create | Japanese Greetings | Closing
Removed from product
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Word: Mail Merge

Word 2003 Location
Main document setup

Open Data Source

Mail Merge Recipients

Insert Address Block

Insert Greeting Line

Insert Merge Fields

Insert Word Field

Insert Word Field (Ask)

Insert Word Field (Fill-in)

Insert Word Field (IfThenElse)
Insert Word Field (Merge Record #)
Insert Word Field (Merge Sequence :
Insert Word Field (Next Record)
Insert Word Field (Next Record If)
Insert Word Field (Set Bookmark)
Insert Word Field (Skip Record If)
Show Fields/Values

Highlight Merge Fields

Match Fields

Propagate Labels

First

Previous

Record

Next

Last

Find Entry

Error Check Merge

Merge to Document

Merge to Printer

Merge to E-mail

Merge to Fax

Insert Merge Field

Microsoft Office Word 2007 - Command Reference Sheet
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Word 2007 Location
Mailings | Start Mail Merge | Start Mail Merge

Mailings | Start Mail Merge | Select Recipients | Use Existing List
Mailings | Start Mail Merge | Edit Recipient List

Mailings | Write & Insert Fields | Address Block

Mailings | Write & Insert Fields | Greeting Line

Mailings | Write & Insert Fields | Insert Merge Field

Mailings | Write & Insert Fields | Rules

Mailings | Write & Insert Fields | Rules | Ask

Mailings | Write & Insert Fields | Rules | Fill-in

Mailings | Write & Insert Fields | Rules | IfThenElse

Mailings | Write & Insert Fields | Rules | Merge Record #
Mailings | Write & Insert Fields | Rules | Merge Sequence #
Mailings | Write & Insert Fields | Rules | Next Record
Mailings | Write & Insert Fields | Rules | Next Record If
Mailings | Write & Insert Fields | Rules | Set Bookmark
Mailings | Write & Insert Fields | Rules | Skip Record If
Mailings | Preview Results | Preview Results

Mailings | Write & Insert Fields | Highlight Merge Fields
Mailings | Write & Insert Fields | Match Fields

Mailings | Write & Insert Fields | Update Labels

Mailings | Preview Results | First

Mailings | Preview Results | Previous

Mailings | Preview Results | Record

Mailings | Preview Results | Next

Mailings | Preview Results | Last

Mailings | Preview Results | Find Recipient

Mailings | Preview Results | Auto Check for Errors

Mailings | Finish | Finish & Merge | Edit Individual Documents
Mailings | Finish | Finish & Merge | Print Documents

Mailings | Finish | Finish & Merge | Send E-mail Messages
Office Button | Word Options | Customize | All Commands | Merge to Fax

Mailings | Write & Insert Fields | Insert Merge Fields
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Word: Outlining

Word 2003 Location
Promote to Heading 1

Promote

Outline Level

Demote

Demote to Body Text
Move Up

Move Down

Expand

Collapse

Show Level

First Line Only View
Show Formatting
Update TOC

Goto TOC

Master Document View
Collapse Subdocuments
Create Subdocument
Delete Subdocument
Import Subdocument
Merge Subdocument
Split Subdocument

Protect Subdocument

Microsoft Office Word 2007 - Command Reference Sheet
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Word 2007 Location
Outlining | Outline Tools | Promote to Heading 1

Outlining | Outline Tools | Promote

Outlining | Outline Tools | Outline Level

Outlining | Outline Tools | Demote

Outlining | Outline Tools | Demote to Body Text

Outlining | Outline Tools | Move Up

Outlining | Outline Tools | Move Down

Outlining | Outline Tools | Expand

Outlining | Outline Tools | Collapse

Outlining | Outline Tools | Show Level

Outlining | Outline Tools | Show First Line Only

Outlining | Outline Tools | Show Text Formatting

References | Table of Contents | Update Table

Office Button | Word Options | Customize | All Commands | Go to TOC
Outlining | Master Document | Show Document

Outlining | Master Document | Expand/Collapse Subdocuments
Outlining | Master Document | Create

Outlining | Master Document | Unlink

Outlining | Master Document | Insert

Outlining | Master Document | Merge

Outlining | Master Document | Split

Outlining | Master Document | Lock Document
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Word: Picture

Word 2003 Location Word 2007 Location

Picture > Insert | lllustrations | Picture

Picture > Header & Footer Tools | Design | Insert | Picture
Picture Chart Tools | Layout | Insert | Picture

Color Picture Tools | Format | Adjust | Recolor

More Contrast
Less Contrast
More Brightness
Less Brightness
Crop

Rotate Left 90°
Rotate Left 90°
Rotate Left 90°
Rotate Left 90°
Rotate Left 90°
Rotate Left 90°
Rotate Left 90°

Picture Tools | Format | Adjust | Contrast

Picture Tools | Format | Adjust | Contrast

Picture Tools | Format | Adjust | Brightness

Picture Tools | Format | Adjust | Brightness

Picture Tools | Format | Size | Crop

Page Layout | Arrange | Rotate | Rotate Left 90°

Drawing Tools | Format | Arrange | Rotate | Rotate Left 90°
Chart Tools | Format | Arrange | Rotate | Rotate Left 90°
SmartArt Tools | Format | Arrange | Rotate | Rotate Left 90°
Picture Tools | Format | Arrange | Rotate | Rotate Left 90°
WordArt Tools | Format | Arrange | Rotate | Rotate Left 90°
Text Box Tools | Format | Arrange | Rotate | Rotate Left 90°

Line Style Picture Tools | Format | Picture Styles | Picture Border | Weight
Compress Pictures Picture Tools | Format | Adjust | Compress Pictures

Text Wrapping Picture Tools | Format | Arrange | Text Wrapping

Text Wrapping Page Layout | Arrange | Text Wrapping

Format Object
Format Object

Set Transparent Color

Reset Picture

Microsoft Office Word 2007 - Command Reference Sheet
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Picture Tools | Format
Picture Tools | Format | Picture Styles | Dialog Box Launcher
Picture Tools | Format | Adjust | Recolor | Set Transparent Color

Picture Tools | Format | Adjust | Reset Picture
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Word: Reviewing

Word 2003 Location
Display for Review

Show (Final)
Show (Original)
Show (Comments)

Show (Ink Annotations)

Show (Insertions and Deletions)
Show (Formatting)

Show (Reviewers - All Reviewers)
Show (Balloons - Always)

Show (Balloons - Never)

Show (Balloons - Only for
Comments/Formatting)

Show (Reviewing Pane)
Show (Options)
Previous

Next

Accept Change

Reject Change/Delete Comment
Ink Annotations

Ink Comment
Comment

Highlight

Track Changes

Reply with Changes

End Review

Reviewing Pane

Microsoft Office Word 2007 - Command Reference Sheet
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Word 2007 Location
Review | Tracking | Display for Review

Review | Tracking | Final

Review | Tracking | Original

Review | Tracking | Show Markup | Comments

Review | Tracking | Show Markup | Ink

Review | Tracking | Show Markup | Insertions and Deletions
Review | Tracking | Show Markup | Formatting

Review | Tracking | Show Markup | Reviewers | All Reviewers
Review | Tracking | Balloons | Show Revisions in Balloons
Review | Tracking | Balloons | Show All Revisions Inline

Review | Tracking | Balloons | Show Only Comments and Formatting in
Balloons

Review | Tracking | Reviewing Pane

Reviewing | Tracking | Track Changes | Change Tracking Options
Review | Changes | Previous

Review | Changes | Next

Review | Changes | Accept

Review | Changes | Reject

Review | Ink | Start Inking

Review | Tracking | Show Markup | Ink

Review | Comments | New Comment

Review | Tracking | Show Markup | Markup Area Highlight

Review | Tracking | Track Changes
Office Button | Word Options | Customize | All Commands | Reply with

Office Button | Word Options | Customize | All Commands | End Review

Review | Tracking | Reviewing Pane
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Word: Tables and Borders

Word 2003 Location

Word 2007 Location

Draw Table > Table Tools | Design | Draw Borders | Draw Table
Draw Table > Home | Paragraph | Borders | Draw Table
Draw Table > Insert | Tables | Table | Draw Table
Draw Table > Table Tools | Design | Table Styles | Borders | Draw Table
Eraser > Table Tools | Design | Draw Borders | Eraser
Border Style > Table Tools | Design | Draw Borders | Pen Style
Border Width > Table Tools | Design | Draw Borders | Pen Weight
Border Color > Table Tools | Design | Draw Borders | Pen Color
Borders > Table Tools | Design | Table Styles | Borders
Shading Color > Table Tools | Design | Table Styles | Shading
Insert Table (Insert Table) > Insert | Tables | Table | Insert Table
Insert Table (Insert Columns to the Left) > Table Tools | Layout | Rows & Columns | Insert Left
Insert Table (Insert Columns to the Right) > Table Tools | Layout | Rows & Columns | Insert Left
Insert Table (Insert Rows Above) > Table Tools | Layout | Rows & Columns | Insert Above
Insert Table (Insert Rows Below) > Table Tools | Layout | Rows & Columns | Insert Below
Insert Tablel(nsertcells) - Tgble Tools | Layout | Rows & Columns |
Dialog Box Launcher
Insert Table (AutoFit to Content) > Table Tools | Layout | Cell Size | AutoFit | AutoFit Contents
Insert Table (AutoFit to Window) > Table Tools | Layout | Cell Size | AutoFit | AutoFit Window
Insert Table (Fixed Column Width) > Table Tools | Layout | Cell Size | AutoFit | Fixed Column Width
Table Tools | Layout | Rows & Columns | Delete | Delete
Delete Columns >
Columns
Delete Rows > Table Tools | Layout | Rows & Columns | Delete | Delete Rows
Delete Cells > Table Tools | Layout | Rows & Columns | Delete | Delete Cells
AutoFit to Contents > Table Tools | Layout | Cell Size | AutoFit | AutoFit Contents
AutoFit to Window > Table Tools | Layout | Cell Size | AutoFit | AutoFit Window
Fixed Column Width > Table Tools | Layout | Cell Size | AutoFit | Fixed Column Width
Show/Hide Gridlines > Table Tools | Layout | Table | View/Hide Gridlines
Merge Cells > Table Tools | Layout | Merge | Merge Cells
Split Cells > Table Tools | Layout | Merge | Split Cells
Cell Alignment > Table Tools | Layout | Alignment
Distribute Rows Evenly > Table Tools | Layout | Cell Size | Distribute Rows
Distribute Columns Evenly > Table Tools | Layout | Cell Size | Distribute Columns
Table AutoFormat > Table Tools | Design | Table Styles
Change Text Direction > Table Tools | Layout | Alignment | Text Direction
Sort Ascending > Table Tools | Layout | Data | Sort
Sort Descending > Table Tools | Layout | Data | Sort
AutoSum > Table Tools | Layout | Data | Formula

Microsoft Office Word 2007 - Command Reference Sheet
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Word: Visual Basic
Word 2003 Location
Macros

Macros

Record New Macro
Record New Macro
Security

Visual Basic Editor
Control Toolbox
Design Mode
Microsoft Script Editor

Microsoft Office Word 2007 - Command Reference Sheet

Word 2007 Location

View | Macros | Macros

Developer | Code | Macros

Developer | Code | Record Macro
View | Macros | Macros | Record Macro
Developer | Code | Macro Security
Developer | Code | Visual Basic
Developer | Controls

Developer | Controls | Design Mode
Removed from product
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Word: Web
Word 2003 Location Word 2007 Location
Back > Office Button | Word Options | Customize | Al Commands | Back
Forward > Office Button | Word Options | Customize | Al Commands | Forward
Stop > Removed from product
Refresh > Removed from product
Start Page > Removed from product
Search the Web > Removed from product
Favorites (Add to Favorites) - Offlce_ Button | Word Options | Customize | All Commands | Add to
Favorites
Favorites (Open Favorites) > Removed from product
Go (Open Hyperlink) > Removed from product
Go (Back) > Office Button | Word Options | Customize | All Commands | Back
Go (Forward) > Office Button | Word Options | Customize | All Commands | Forward
Go (Start Page) > Removed from product
Go (Search the Web) > Removed from product
Go (Set Search Page) > Removed from product
Show Only Web Toolbar > Removed from product
Address > Office Button | Prepare | Properties | Location

Microsoft Office Word 2007 - Command Reference Sheet
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Word: Web Tools

Word 2003 Location

Design Mode
Properties
Checkbox
Option Button
Drop-Down Box
List Box
Textbox

Text Area
Submit

Submit with Image
Reset

Hidden

Password

Movie
Sound
Scrolling Text

Microsoft Office Word 2007 - Command Reference Sheet

Word 2007 Location
Office Button | Word Options | Customize | All Commands | Web Design
Mode

Office Button | Word Options | Customize | All Commands | Property Sheet

Office Button | Word Options | Customize | All Commands | Check Box
(Web Control)

Office Button | Word Options | Customize | All Commands | Option Button
(Web Control)

Office Button | Word Options | Customize | All Commands | Drop-Down Box
(Web Control)

Office Button | Word Options | Customize | All Commands | List Box (Web
Control)

Office Button | Word Options | Customize | All Commands | Text Box (Web
Control)

Office Button | Word Options | Customize | All Commands | Text Area (Web
Control)

Office Button | Word Options | Customize | All Commands | Submit (Web
Control)

Office Button | Word Options | Customize | All Commands | Submit with
Image (Web Control)

Office Button | Word Options | Customize | All Commands | Reset (Web
Control)

Office Button | Word Options | Customize | All Commands | Hidden (Web
Control)

Office Button | Word Options | Customize | All Commands | Password
(Web Control)

Removed from product
Removed from product

Removed from product
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Word: Word Count

Word 2003 Location Word 2007 Location
Word Count Statistics > Review | Proofing | Word Count
Word Count Statistics > Status Bar | Word Count

Recount > Office Button | Word Options | Customize | Al Commands | Recount

Microsoft Office Word 2007 - Command Reference Sheet
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Word: WordArt

Word 2003 Location
WordArt

Edit Text

WordArt Gallery

Format Object

WordArt Shape

Text Wrapping

WordArt Same Letter Heights
WordArt Vertical Text
WordArt Alignment

WordArt Character Spacing

Microsoft Office Word 2007 - Command Reference Sheet
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Word 2007 Location
Insert or Select WordArt text to see the WordArt Tools tab

WordArt Tools | Format | Text | Edit Text

WordArt Tools | Format | WordArt Styles

WordArt Tools | Format | Size | Dialog Box Launcher

WordArt Tools | Format | WordArt Styles | Change WordArt Shape
WordArt Tools | Format | Arrange | Text Wrapping

WordArt Tools | Format | Text | Even Height

WordArt Tools | Format | Text | Vertical Text

WordArt Tools | Format | Text | Alignment

WordArt Tools | Format | Text | Spacing
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Word: 3-D Settings

Word 2003 Location
3-D On/Off

3-D On/Off
3-D On/Off
3-D On/Off
3-D On/Off

3-D On/Off

3-D On/Off

Tilt Down
Tilt Down
Tilt Down
Tilt Down
Tilt Down

Tilt Down

Tilt Down

Tilt Up
Tilt Up
Tilt Up
Tilt Up
Tilt Up

Tilt Up

Tilt Up

Tilt Left
Tilt Left
Tilt Left
Tilt Left

Tilt Left
Tilt Left
Tilt Left

Tilt Right
Tilt Right
Tilt Right
Tilt Right
Tilt Right

Tilt Right

Tilt Right

Depth

Microsoft Office Word 2007 - Command Reference Sheet

Word 2007 Location

Drawing Tools | Format | 3-D Effects | 3-D On/Off
Organization Chart Tools | Format | 3-D Effects | 3-D On/Off
Diagram Tools | Format | 3-D Effects | 3-D On/Off

WordArt Tools | Format | 3-D Effects | 3-D On/Off

Text Box Tools | Format | 3-D Effects | 3-D On/Off

SmartArt Tools | Format | Shape Styles | Shape Effects | 3-D Rotation

Picture Tools | Format | Picture Styles | Picture Effects | 3-D Rotation

Drawing Tools | Format | 3-D Effects | Tilt Down
Organization Chart Tools | Format | 3-D Effects | Tilt Down
Diagram Tools | Format | 3-D Effects | Tilt Down
WordArt Tools | Format | 3-D Effects | Tilt Down
Text Box Tools | Format | 3-D Effects | Tilt Down

SmartArt Tools | Format | Shape Styles | Dialog Box Launcher | 3-D
Rotation | Rotation | Down

Picture Tools | Format | Picture Styles | Dialog Box Launcher | 3-D Rotation |
Rotation | Down

Drawing Tools | Format | 3-D Effects | Tilt Up
Organization Chart Tools | Format | 3-D Effects | Tilt Up
Diagram Tools | Format | 3-D Effects | Tilt Up
WordArt Tools | Format | 3-D Effects | Tilt Up
Text Box Tools | Format | 3-D Effects | Tilt Up

SmartArt Tools | Format | Shape Styles | Dialog Box Launcher | 3-D
Rotation | Rotation | Up

Picture Tools | Format | Picture Styles | Dialog Box Launcher | 3-D Rotation |
Rotation | Up

Drawing Tools | Format | 3-D Effects | Tilt Left
Organization Chart Tools | Format | 3-D Effects | Tilt Left
Diagram Tools | Format | 3-D Effects | Tilt Left
WordArt Tools | Format | 3-D Effects | Tilt Left

Picture Tools | Format | Picture Styles | Dialog Box Launcher | 3-D Rotation |
Rotation | Left

Text Box Tools | Format | 3-D Effects | Tilt Left

SmartArt Tools | Format | Shape Styles | Dialog Box Launcher | 3-D
Rotation | Rotation | Left

Drawing Tools | Format | 3-D Effects | Tilt Right
Organization Chart Tools | Format | 3-D Effects | Tilt Right
Diagram Tools | Format | 3-D Effects | Tilt Right
WordArt Tools | Format | 3-D Effects | Tilt Right
Text Box Tools | Format | 3-D Effects | Tilt Right

SmartArt Tools | Format | Shape Styles | Dialog Box Launcher | 3-D
Rotation | Rotation | Right

Picture Tools | Format | Picture Styles | Dialog Box Launcher | 3-D Rotation |
Rotation | Right

Drawing Tools | Format | 3-D Effects |[Depth
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Word: 3-D Settings

Word 2003 Location

Depth

Depth
Depth
Depth

Depth

Depth
Direction
Direction

Direction
Direction

Direction

Direction

Direction
Lighting
Lighting

Lighting
Lighting
Lighting

Lighting

Lighting
Surface
Surface

Surface
Surface

Surface

Surface

Surface
3-D Color
3-D Color

3-D Color
3-D Color
3-D Color

3-D Color

3-D Color

Microsoft Office Word 2007 - Command Reference Sheet

Word 2007 Location
Organization Chart Tools | Format | 3-D Effects | 3-D Effects | Depth

Diagram Tools | Format | 3-D Effects | 3-D Effects | Depth
WordArt Tools | Format | 3-D Effects | 3-D Effects | Depth
Text Box Tools | Format | 3-D Effects | 3-D Effects | Depth

SmartArt Tools | Format | Shape Styles | Dialog Box Launcher | 3-D Format
| Depth | Depth

Picture Tools | Format | Picture Styles | Dialog Box Launcher | 3-D Format |
Depth | Depth

Drawing Tools | Format | 3-D Effects | 3-D Effects | Direction

Organization Chart Tools | Format | 3-D Effects | 3-D Effects | Direction

Diagram Tools | Format | 3-D Effects | 3-D Effects | Direction
WordArt Tools | Format | 3-D Effects | 3-D Effects | Direction
Text Box Tools | Format | 3-D Effects | 3-D Effects | Direction

SmartArt Tools | Format | Shape Styles | Shape Effects | 3-D Rotation

Picture Tools | Format | Picture Styles | Picture Effects | 3-D Rotation
Drawing Tools | Format | 3-D Effects | 3-D Effects | Lighting
Organization Chart Tools | Format | 3-D Effects | 3-D Effects | Lighting

Diagram Tools | Format | 3-D Effects | 3-D Effects | Lighting
WordArt Tools | Format | 3-D Effects | 3-D Effects | Lighting
Text Box Tools | Format | 3-D Effects | 3-D Effects | Lighting

SmartArt Tools | Format | Shape Styles | Dialog Box Launcher | 3-D Format
| Surface | Lighting
Picture Tools | Format | Picture Styles | Dialog Box Launcher | 3-D Format |
Surface | Lightning

Drawing Tools | Format | 3-D Effects | 3-D Effects | Surface
Organization Chart Tools | Format | 3-D Effects | 3-D Effects | Surface

Diagram Tools | Format | 3-D Effects | 3-D Effects | Surface
WordArt Tools | Format | 3-D Effects | 3-D Effects | Surface
Text Box Tools | Format | 3-D Effects | 3-D Effects | Surface

SmartArt Tools | Format | Shape Styles | Dialog Box Launcher | 3-D Format
| Surface | Material

Picture Tools | Format | Picture Styles | Dialog Box Launcher | 3-D Format |
Surface | Material

Drawing Tools | Format | 3-D Effects | 3-D Effects | 3-D Color
Organization Chart Tools | Format | 3-D Effects | 3-D Effects | 3-D Color

Diagram Tools | Format | 3-D Effects | 3-D Effects | 3-D Color
WordArt Tools | Format | 3-D Effects | 3-D Effects | 3-D Color
Text Box Tools | Format | 3-D Effects | 3-D Effects | 3-D Color

SmartArt Tools | Format | Shape Styles | Dialog Box Launcher | 3-D Format
| Depth | Color

Picture Tools | Format | Picture Styles | Dialog Box Launcher | 3-D Format |
Depth | Color
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Word 2003 Location Word 2007 Location

Shadow On/Off > Drawing Tools | Format | Shadow Effects | Shadow On/Off

Shadow On/Off > Organization Chart Tools | Format | Shadow Effects | Shadow On/Off

Shadow On/Off > Diagram Tools | Format | Shadow Effects | Shadow On/Off

Shadow On/Off > Picture Tools | Format | Shadow Effects | Shadow On/Off

Shadow On/Off > WordArt Tools | Format | Shadow Effects | Shadow On/Off

Shadow On/Off > Text Box Tools | Format | Shadow Effects | Shadow On/Off

Shadow On/Off > SmartArt Tools | Format | Shape Styles | Shape Effects | Shadow

Shadow On/Off > Chart Tools | Format | Shape Styles | Shape Effects | Shadow

Nudge Shadow Up > Drawing Tools | Format | Shadow Effects | Nudge Shadow Up

Nudge Shadow Up > Organization Chart Tools | Format | Shadow Effects | Nudge Shadow Up

Nudge Shadow Up > Diagram Tools | Format | Shadow Effects | Nudge Shadow Up

Nudge Shadow Up > Picture Tools | Format | Shadow Effects | Nudge Shadow Up

Nudge Shadow Up > WordArt Tools | Format | Shadow Effects | Nudge Shadow Up

Nudge Shadow Up > Text Box Tools | Format | Shadow Effects | Nudge Shadow Up

Nudge Shadow Up SmartAr.t Tools | Format | Shape Styles | Dialog Box Launcher | Shadow |
Angle/Distance

I e Picture Tools | Format | Picture Styles | Dialog Box Launcher | Shadow |
Angle/Distance

Nudge Shadow Down > Drawing Tools | Format | Shadow Effects | Nudge Shadow Down

Nudge Shadow Down > Organization Chart Tools | Format | Shadow Effects | Nudge Shadow Down

Nudge Shadow Down > Diagram Tools | Format | Shadow Effects | Nudge Shadow Down

Nudge Shadow Down > Picture Tools | Format | Shadow Effects | Nudge Shadow Down

Nudge Shadow Down > WordArt Tools | Format | Shadow Effects | Nudge Shadow Down

Nudge Shadow Down > Text Box Tools | Format | Shadow Effects | Nudge Shadow Down

Nudge Shadow Down SmartAr't Tools | Format | Shape Styles | Dialog Box Launcher | Shadow |
Angle/Distance

s Sl B Picture Tools | Format | Picture Styles | Dialog Box Launcher | Shadow |
Angle/Distance

Nudge Shadow Left > Drawing Tools | Format | Shadow Effects | Nudge Shadow Left

Nudge Shadow Left > Organization Chart Tools | Format | Shadow Effects | Nudge Shadow Left

Nudge Shadow Left > Diagram Tools | Format | Shadow Effects | Nudge Shadow Left

Nudge Shadow Left > Picture Tools | Format | Shadow Effects | Nudge Shadow Left

Nudge Shadow Left > WordArt Tools | Format | Shadow Effects | Nudge Shadow Left

Nudge Shadow Left > Text Box Tools | Format | Shadow Effects | Nudge Shadow Left

Nudge Shadow Left SmartAr't Tools | Format | Shape Styles | Dialog Box Launcher | Shadow |
Angle/Distance

Nudge Shaclow Left Picture Tools | Format | Picture Styles | Dialog Box Launcher | Shadow |
Angle/Distance

Nudge Shadow Right > Drawing Tools | Format | Shadow Effects | Nudge Shadow Right

Nudge Shadow Right > Organization Chart Tools | Format | Shadow Effects | Nudge Shadow Right

Nudge Shadow Right > Diagram Tools | Format | Shadow Effects | Nudge Shadow Right

Nudge Shadow Right > Picture Tools | Format | Shadow Effects | Nudge Shadow Right
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Word: Shadow Settings

Word 2003 Location
Nudge Shadow Right

Nudge Shadow Right

Nudge Shadow Right
Nudge Shadow Right
Shadow Color
Shadow Color
Shadow Color

Shadow Color
Shadow Color
Shadow Color

Shadow Color

Shadow Color

Microsoft Office Word 2007 - Command Reference Sheet

Word 2007 Location
WordArt Tools | Format | Shadow Effects | Nudge Shadow Right
Text Box Tools | Format | Shadow Effects | Nudge Shadow Right

SmartArt Tools | Format | Shape Styles | Dialog Box Launcher | Shadow |
Angle/Distance

Picture Tools | Format | Picture Styles | Dialog Box Launcher | Shadow |
Angle/Distance

Chart Tools | Format | Shape Styles | Dialog Box Launcher | Shadow | Color

SmartArt Tools | Format | Shape Styles | Dialog Box Launcher | Shadow |
Color

Drawing Tools | Format | Shadow Effects| Shadow Effects | Shadow Color

Organization Chart Tools | Format | Shadow Effects | Shadow Color

Diagram Tools | Format | Shadow Effects | Shadow Color

Picture Tools | Format | Picture Styles | Pictures Effects | Shadow | Shadow
Color

WordArt Tools | Format | Shadow Effects | Shadow Color
Text Box Tools | Format | Shadow Effects | Shadow Color
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Word: Drawing Canvas

Word 2003 Location

Fit
Expand
Scale Drawing

Text Wrapping
Text Wrapping
Text Wrapping
Text Wrapping
Text Wrapping
Text Wrapping
Text Wrapping
Text Wrapping
Text Wrapping

Microsoft Office Word 2007 - Command Reference Sheet
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Word 2007 Location
Office Button | Word Options | Customize | All Commands | Fit Drawing to
Contents

Office Button | Word Options | Customize | All Commands | Expand
Office Button | Word Options | Customize | All Commands | Scale Drawing

Drawing Tools | Format | Arrange | Text Wrapping

SmartArt Tools | Format | Arrange | Text Wrapping

Chart Tools | Format | Arrange | Text Wrapping

Picture Tools | Format | Arrange | Text Wrapping

WordArt Tools | Format | Arrange | Text Wrapping

Diagram Tools | Format | Arrange | Text Wrapping
Organization Chart Tools | Format | Arrange | Text Wrapping
Page Layout | Arrange | Text Wrapping

Text Box Tools | Format | Arrange | Text Wrapping
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Word: Organization Chart

Word 2003 Location

Insert Shape

Insert Shape

Layout (Standard)
Layout (Standard)
Layout (Both Hanging)

Layout (Both Hanging)
Layout (Left Hanging)
Layout (Left Hanging)
Layout (Right Hanging)

Layout (Right Hanging)
Layout (AutoLayout)
Layout (AutoLayout)

Select (Level)
Select (Branch)

Select (All Assistants)

Select (All Connecting Lines)

Autoformat
Autoformat
Text Wrapping
Text Wrapping

Zoom

Zoom

Microsoft Office Word 2007 - Command Reference Sheet

Word 2007 Location
SmartArt Design | Create Graphic | Layout | Add Shape

Organization Chart Tools | Format | Insert

SmartArt Design | Create Graphic | Layout | Standard
Organization Chart Tools | Format | Layout | Standard
SmartArt Design | Create Graphic | Layout | Both

Organization Chart Tools | Format | Layout | Both Hanging
SmartArt Design | Create Graphic | Layout | Left Hanging
Organization Chart Tools | Format | Layout | Left Hanging
SmartArt Design | Create Graphic | Layout | Right Hanging

Organization Chart Tools | Format | Layout | Right Hanging
SmartArt Tools | Design | Layouts
Organization Chart Tools | Format | Layout | AutoLayout

Organization Chart Tools | Format | Select | Level

Organization Chart Tools | Format | Select | Branch

Organization Chart Tools | Format | Select | All Assistants

Organization Chart Tools | Format | Select | All Connectors

SmartArt Tools | Design | SmartArt Styles
Organization Chart Tools | Format | Styles | Style
SmartArt Tools | Format | Arrange | Text Wrapping

Organization Chart Tools | Format | Arrange | Text Wrapping

View | Zoom | Zoom

Status Bar | Zoom Slider
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Word 2003 Location
Insert Shape

Insert Shape
Move Shape Backward

Move Shape Backward
Move Shape Forward
Move Shape Forward
Reverse Diagram
Reverse Diagram

Layout (Fit Diagram to Contents)
Layout (Expand Diagram)
Layout (Expand Diagram)
Layout (Resize Diagram)
Layout (AutoLayout)
Layout (AutoLayout)
AutoFormat

AutoFormat

Change to

Change to

Change to (Cycle)
Change to (Cycle)
Change to (Radial)
Change to (Radial)
Change to (Pyramid)
Change to (Pyramid)
Change to (Venn)
Change to (Venn)
Change to (Target)
Change to (Target)

Text Wrapping

Text Wrapping

Microsoft Office Word 2007 - Command Reference Sheet
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Word 2007 Location
Smart Art Tools | Design | Create Graphic | Add Shape

Diagram Tools | Format | Layout | Insert Shape
SmartArt Tools | Format | Arrange | Send to Back | Send Backward

Diagram Tools | Format | Layout | Move Shape Backward
SmartArt Tools | Format | Arrange | Bring to Front | Bring Forward
Diagram Tools | Format | Layout | Move Shape Forward
SmartArt Tools | Design | Create Graphic | Right to Left
Diagram Tools | Format | Layout | Reverse

Diagram Tools | Format | Layout | Fit to Contents
SmartArt Tools | Format | Size

Diagram Tools | Format | Layout | Expand

Diagram Tools | Format | Layout | Resize

SmartArt Tools | Design | Layouts

Diagram Tools | Format | Layout | AutoLayout

SmartArt Tools | Design | Styles

Diagram Tools | Format | Styles | Diagram Styles
SmartArt Tools | Design | Layouts | More Layouts
Diagram Tools | Format | Styles | Change To

SmartArt Tools | Design | Layouts | More Layouts
Diagram Tools | Format | Styles | Change To | Cycle
SmartArt Tools | Design | Layouts | More Layouts
Diagram Tools | Format | Styles | Change To | Radial
SmartArt Tools | Design | Layouts | More Layouts
Diagram Tools | Format | Styles | Change To | Pyramid
SmartArt Tools | Design | Layouts | More Layouts
Diagram Tools | Format | Styles | Change To | Venn
SmartArt Tools | Design | Layouts | More Layouts
Diagram Tools | Format | Styles | Change To | Target
SmartArt Tools | Format | Arrange | Text Wrapping
Diagram Tools | Format | Arrange | Text Wrapping
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Word: Header and Footer

Word 2003 Location
Insert AutoText

Insert AutoText

Page Number

Page Number
Number of Pages
Number of Pages
Format Page Numbers

Format Page Numbers

Date
Time
Page Setup
Page Setup

Hide Body Text

Link to Previous
Show Header/Footer
Previous Header
Next Header

Close

Microsoft Office Word 2007 - Command Reference Sheet
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Word 2007 Location
Insert | Headers & Footers | Footer

Insert | Headers & Footers | Header

Insert | Headers & Footers | Page Number

Header & Footer Tools | Design | Headers & Footer | Page Number
Insert | Headers & Footers | Page Number

Header & Footer Tools | Design | Headers & Footer | Page Number
Insert | Header & Footer | Page Number | Format Page Numbers

Header & Footer Tools | Design | Header & Footer | Page Number | Format
Page Numbers

Header & Footer Tools | Design | Insert | Date & Time
Header & Footer Tools | Design | Insert | Date & Time
Print Preview | Page Setup | Page Setup
Page Layout | Page Setup | Page Setup

Office Button | Word Options | Customize | All Commands | Hide Body Text
Header & Footer Tools | Design | Navigation | Link to Previous
Office Button | Word Options | Customize | All Commands | Show

Header & Footer Tools | Design | Navigation | Previous Section
Header & Footer Tools | Design | Navigation | Next Section

Header & Footer Tools | Design | Close | Close Header and Footer
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Word: Full Screen
Word 2003 Location
Close Full Screen

Microsoft Office Word 2007 - Command Reference Sheet

Word 2007 Location
> When in Full Screen Reading Mode | Close
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Word: Stop Recording

Word 2003 Location
Stop Recording

Stop Recording
Pause Recording
Pause Recording

Microsoft Office Word 2007 - Command Reference Sheet

Word 2007 Location

Developer | Code | Stop Recording

View | Macros | Macros | Stop Recording
Developer | Code | Pause Recording
View | Macros | Macros | Pause Recording
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Word: Microsoft

Word 2003 Location
Microsoft Excel

Microsoft Office PowerPoint
Microsoft Outlook

Microsoft Access
Microsoft Visual FoxPro

Microsoft Project
Microsoft Schedule+

Microsoft Publisher

Microsoft Office Word 2007 - Command Reference Sheet

Word 2007 Location
Office Button | Word Options | Customize | All Commands | Microsoft Excel

Office Button | Word Options | Customize | All Commands | Microsoft Office
PowerPoint

Office Button | Word Options | Customize | All Commands | Microsoft Outlook

Office Button | Word Options | Customize | All Commands | Microsoft Access
Removed from product

Office Button | Word Options | Customize | All Commands | Microsoft Project
Office Button | Word Options | Customize | All Commands | Microsoft Schedule+

Office Button | Word Options | Customize | All Commands | Microsoft Publisher
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Word: Print Preview

Word 2003 Location

Word 2007 Location

Print >

\%

Magnifier

One Page
Multiple Pages
Zoom

Zoom

Ruler

Shrink One Page
Full Screen

vV VvV Vv VvV V Vv V V

Close

Microsoft Office Word 2007 - Command Reference Sheet

Office Button | Print | Quick Print

Print Preview | Preview | Magnifier

Print Preview | Zoom | One Page

Print Preview | Zoom | Zoom | Many Pages

Print Preview | Zoom

Status Bar | Zoom Slider

Print Preview | Preview | Show Ruler

Print Preview | Preview | Shrink One Page

Office Button | Word Options | Customize | All Commands | Full Screen Reading

Print Preview | Preview | Close Print Preview
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Word: AutoSummarize

Word 2003 Location

Highlight/Show Only Summary
Percent of Original

Close

Microsoft Office Word 2007 - Command Reference Sheet

Word 2007 Location

Office Button | Word Options | Customize | All Commands | AutoSummary
Tools | Highlight/Show Only Summary

Office Button | Word Options | Customize | All Commands | AutoSummary
Tools | Auto Summarize | Percent Of Original

Office Button | Word Options | Customize | All Commands | AutoSummary
Tools | Close
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Word: Exit Desigh Mode
Word 2003 Location
Design Mode

Microsoft Office Word 2007 - Command Reference Sheet

Word 2007 Location
> Developer | Controls | Design Mode
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Word: Text Box
Word 2003 Location
Create Text Box Link

Break Forward Link
Previous Text Box
Next Text Box

\%

Change Text Direction
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Change Text Direction

Microsoft Office Word 2007 - Command Reference Sheet

Word 2007 Location

Text Box Tools | Format | Text | Create Link

Text Box Tools | Format | Text | Break Link

Office Button | Word Options | Customize | All Commands | Previous Text Box
Office Button | Word Options | Customize | All Commands | Next Text Box
Table Tools | Layout | Alignment | Text Direction

Text Box Tools | Format | Text | Text Direction

63



Cla vicoso .
. 1.0ffice Online

Word: Refresh
Word 2003 Location
Refresh

Do Not Refresh

Microsoft Office Word 2007 - Command Reference Sheet

Word 2007 Location
> Removed from product

> Removed from product
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Word: Reading Layout

Word 2003 Location Word 2007 Location

Save > Quick Access Toolbar | Save

Save Office Button | Save

Print Office Button | Print | Quick Print

Document Map Reading Layout | Page 1 of 1 | Document Map
Thumbnails Reading Layout | Page 1 of 1 | Thumbnails
Find Reading Layout | Tools | Find

Find Reading Layout | Page 1 of 1 | Find

Research Reading Layout | Tools | Research

Increase Text Size
Decrease Text Size
Actual Page

Allow Multiple Pages
Close

Start of Document

Microsoft Office Word 2007 - Command Reference Sheet
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Reading Layout | View Options | Increase Text Size
Reading Layout | View Options | Decrease Text Size
Reading Layout | View Options | Show One Page
Reading Layout | View Options | Show Two Pages
Reading Layout | Close

Reading Layout | Page 1 of 1 | Go to First Page
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Word: Compare Side by Side

Word 2003 Location
Synchronous Scrolling

Reset Window Position
Compare Side by Side with

Microsoft Office Word 2007 - Command Reference Sheet

Word 2007 Location

View | Window | Synchronous Scrolling
View | Window | Reset Window Position
View | Window | View Side by Side
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Word: System
Word 2003 Location
Restore

Move
Size
Minimize
Maximize

Close

Microsoft Office Word 2007 - Command Reference Sheet

Word 2007 Location

Title Bar | Restore

Title Bar Right Click Menu | Move
Title Bar Right Click Menu | Size
Title Bar | Minimize

Title Bar | Maximize

Title Bar | Close
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Word: Online Meeting

Word 2003 Location
Participant List

Call Participants

Remove Participants
Allow Others to Edit
Display Chat Window
Display W hiteboard
End Meeting

Microsoft Office Word 2007 - Command Reference Sheet
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Word 2007 Location
Removed from product

Removed from product
Removed from product
Removed from product
Removed from product
Removed from product
Removed from product
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